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Software Copyright and Warranty
This legal document is an agreement between you, the
end user, and BIAS, Inc. BY UTILIZING THE SOFTWARE ON
THESE DISKS, YOU ARE AGREEING TO BECOME BOUND
BY THE TERMS OF THIS AGREEMENT, WHICH INCLUDES
THE SOFTWARE LICENSE AND THE SOFTWARE DIS-
CLAIMER OF WARRANTY (collectively the “Agreement”).
THIS AGREEMENT CONSTITUTES THE COMPLETE AGREE-
MENT BETWEEN YOU AND BIAS, INC. IF YOU DO NOT
AGREE TO THE TERMS OF THIS AGREEMENT, DO NOT
USE THE SOFTWARE ON THE DISKS INCLUDED IN THIS
PACKAGE AND PROMPTLY RETURN THE UNOPENED PACK-
AGE AND THE OTHER MATERIALS (INCLUDING WRITTEN
MATERIALS, BINDERS OR OTHER CONTAINERS) THAT ARE
PART OF THIS PRODUCT TO THE PLACE WHERE YOU
OBTAINED THEM FOR A FULL REFUND. BIAS SOFTWARE
LICENSE
1. GRANT OF LICENSE. In consideration of payment of the
LICENSE fee, which is part of the price you paid for this
product, BIAS, as Licensor, grants to you, the LICENSEE, a
non-exclusive right to use and display this copy of a BIAS
software program (hereinafter the “SOFTWARE”) an a single
COMPUTER (i.e., with a single CPU) at a single location.
BIAS reserves all rights not expressly granted to LICENSEE.
2. OWNERSHIP OF SOFTWARE. As the LICENSEE, you own
the magnetic or other physical media on which the SOFT-
WARE is originally or subsequently recorded or fixed, but
BIAS retains title and ownership of the SOFTWARE record-
ed on the original disk copy (or copies) and all subsequent
copies of the SOFTWARE, regardless of the form or media
on which the original and other copies may exist. This
License is not a sale of the original SOFTWARE or any copy.
3. COPY RESTRICTIONS. This SOFTWARE and the accom-
panying written materials are copyrighted. Unauthorized
copying of the SOFTWARE, including SOFTWARE that has
been modified, merged, or included with other software, or
of the written materials is expressly forbidden. You may be
held legally responsible for any copyright infringement that
is caused or encouraged by your failure to abide by the
terms of this License. Subject to these restrictions, and if the
SOFTWARE is not copy-protected, you may make one (1)
copy of the SOFTWARE solely for backup purposes. You
must reproduce and include the copyright notice on the
backup copy.
4. USE RESTRICTIONS. As the LICENSEE, you may physical-
ly transfer the SOFTWARE from one computer to another
provided that the SOFTWARE is used on only one comput-
er at a time. You may not electronically transfer the

SOFTWARE from one computer to another over a network.
You may not distribute copies of the SOFTWARE or accom-
panying written materials to others. You may not modify,
adapt, translate, reverse engineer, de-compile, disassemble,
or create derivative works based on the SOFTWARE. You
may not modify, adapt, translate, or create derivative works-
based on the written materials without the priorwritten con-
sent of BIAS.
5. TRANSFER RESTRICTIONS. This SOFTWARE is licensed
only to you, the LICENSEE, and may not be transferred to
anyone without the prior written consent of BIAS. Any
authorized transferee of the SOFTWARE shall be bound by
the terms and conditions of this Agreement. In no event
may you transfer, assign, rent, lease, sell, or otherwise dis-
pose of the SOFTWARE on a temporary or permanent basis
except as expressly provided herein.
6. TERMINATION. This License is effective until terminated.
This License will terminate automatically without notice
from BIAS if you fail to comply with any provision of this
License. Upon termination you shall destroy the written
materials and all copies of the SOFTWARE, including modi-
fied copies, if any.
7. UPDATE POLICY. BIAS may create, from time to time,
updated versions of the SOFTWARE. At its option, BIAS will
make such updates available to the LICENSEE and transfer-
ees who have paid the update fee and returned the registra-
tion card to BIAS.
8. MISCELLANEOUS. This Agreement is governed by the law
of the State of California.
DISCLAIMER OF WARRANTY AND LIMITED WARRANTY
THE SOFTWARE AND ACCOMPANYING WRITTEN MATERI-
ALS (INCLUDING INSTRUCTIONS FOR USE) ARE PROVID-
ED “AS IS” WITHOUT WARRANTIES OF ANY KIND. FUR-
THER, BIAS DOES NOT WARRANT, GUARANTEE, OR MAKE
ANY REPRESENTATIONS REGARDING THE USE, OR THE
RESULTS OF THE USE, OF THE SOFTWARE OR WRITTEN
MATERIALS IN TERMS OF CORRECTNESS, ACCURACY,
RELIABILITY, CURRENTNESS, OR OTHERWISE. THE
ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF
THE SOFTWARE IS ASSUMED BY YOU, AND NOT BIAS OR
ITS DEALERS, DISTRIBUTORS, AGENTS, OR EMPLOYEES,
YOU AGREE TO ASSUME THE ENTIRE COST OF ALL NEC-
ESSARY SERVICING, REPAIR, OR CORRECTION. BIAS war-
rants to the original LICENSEE that the disk(s) on which the
SOFTWARE is recorded is free from defects in materials and
workmanship under normal use and service for a period of
ninety (90) days from the date of delivery as evidenced by a
copy of the receipt. 



Further, BIAS hereby limits the duration of any implied war-
ranty (or warranties) on the disk to the respective periods
stated above. Some states do not allow limitations on dura-
tion of an implied warranty, so the above limitation may not
apply to you. BIAS’ entire liability and your exclusive reme-
dy as to disk(s) shall be, at BIAS’ option, either (a) return of
the purchase price or (b) replacement of the disk that does
not meet BIAS’ Limited Warranty and which is returned to
BIAS with a copy of the receipt. If failure of the disk has
resulted from accident, abuse, or misapplication, BIAS shall
have no responsibility to replace the disk or refund the pur-
chase price. Any replacement disk will be warranted for the
remainder of the original warranty period or thirty (30) days,
whichever is longer.
THE ABOVE ARE THE ONLY WARRANTIES OF ANY KIND,
EITHER EXPRESS OR IMPLIED, INCLUDING BUT NOT LIM-
ITED TO THE IMPLIED WARRANTIES OF MERCHANTABILI-
TY AND FITNESS FOR A PARTICULAR PURPOSE, THAT ARE
MADE BY BIAS CONCERNING THE BIAS PRODUCT. NO
ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY
BIAS, ITS DEALERS, DISTRIBUTORS, AGENTS, OR EMPLOY-
EES SHALL CREATE A WARRANTY OR IN ANY WAY
INCREASE THE SCOPE OF THIS WARRANTY, AND YOU MAY
NOT RELY ON ANY SUCH INFORMATION OR ADVICE. THIS
WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS. YOU
MAY HAVE OTHER RIGHTS WHICH VARY FROM STATE TO
STATE. NEITHER BIAS NOR ANYONE ELSE WHO HAS BEEN
INVOLVED IN THE CREATION, PRODUCTION, OR DELIV-
ERY OF THIS PRODUCT SHALL BE LIABLE FOR  ANY
DIRECT, INDIRECT, CONSEQUENTIAL, OR INCIDENTAL
DAMAGES (INCLUDING DAMAGES FOR LOSS OF BUSI-
NESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSI-
NESS INFORMATION, AND THE LIKE) ARISING SUCH DAM-
AGES. BECAUSE SOME STATES DO NOT ALLOW THE
EXCLUSION OR LIMITATION OF LIABILITY FOR CONSE-
QUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE LIMI-
TATION MAY NOT APPLY TO YOU.
This Disclaimer of Warranty and Limited Warranty is gov-
erned by the laws of the State of California. 

U.S. GOVERNMENT RESTRICTED RIGHTS

The SOFTWARE and documentation is provided with
RESTRICTED RIGHTS. Use, duplication, or disclosure by the
Government is subject to restrictions as set forth in subdivi-
sion (b)(3)(ii) of The Rights in Technical Data and Computer
Software clause at
252.227-7013.

Contractor/manufacturer is:

BIAS (Berkley Integrated Audio Software), Inc.
1370 Industrial Ave.
Suite A
Petaluma, CA 94952
USA

Should you have any questions concerning this Agreement,
or if you desire to contact BIAS for any reason, please con-
tact in writing:

BIAS Customer Sales and Service,
1370 Industrial Ave.
Suite A
Petaluma CA 94952
USA

Copyright 1999–2002 BIAS, Inc.

Credits:
Peak Express™ software:  Steve Berkley.

VST™ is a licensed trademark of Steinberg Media
Technologies, AG.

Mac OS X™, Final Cut Pro™, and Audio Unit™ are licensed
trademarks of Apple Computer, Inc.

User’s Guide:
Zac Wheatcroft.

Special Thanks to:
Bruce Bennett, Christine Berkley, Jason Davies, Ben Hester,
Dan Brennan, Dan Spirlock, Ben Ventura, Caitlin Lampert,
Lisa Stefan, Victor Cebreros, Sam Boyd, Gabe Khofri, Craig
Linsen, Mark Altekruse, Dan Brown, Xander Soren, Roger
Powell. 
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BIAS Product Support:

Unlimited Complimentary Self Help Options

If you have questions about installing or using your BIAS
products, please check the manual or user guide first, you
will find answers to most of your questions there. If you
need further assistance, please check:

http://www.bias-inc.com/support.html

for frequently asked questions, an extensive database of
related articles, troubleshooting tips, and more.

Limited Complimentary Technical Assistance

Ninety days of technical support assistance for up to three
incidents is available with the initial purchase of Type 1 BIAS
products (Peak, Peak TDM, and Deck). Ninety days of tech-
nical support assistance for a single incident is available with
the initial purchase of Type 2 BIAS products (Peak DV, Peak
LE, Deck LE, Vbox, SuperFreq, SoundSoap). Type 3 products
(OEM versions - including Peak Express) are excluded.
Thirty days of technical support assistance for a single inci-
dent is available with the purchase of paid upgrades to Type
1 and Type 2 BIAS products. The support period begins
when the product authorization code (PAC) is initially issued
following the product registration. To receive e-mail or tele-
phone technical support, you will need a valid serial number
and must be registered for a current BIAS product. Please
keep your original product serial number and PAC in a safe
place as it will be required for support.  For customers pre-
ferring e-mail assistance, please use the email form available
on our web site at:

http://www.bias-inc.com/support.html

Or, email:

support@bias-inc.com

For customers preferring telephone assistance, (connect
and toll charges apply), please have your computer running
and close by the phone and call us at:

+1-707-782-1865

9AM-5PM Monday-Friday PST – excluding BIAS holidays

Fee-based Technical Support Options

Fee-based Support is available for those customers whose
support period has expired or for Type 3 (OEM version) cus-
tomers.  Please call:

+1-707-782-1865

9AM-5PM Monday-Friday PST – excluding BIAS holidays

For customers living outside of North America, please con-
tact your local BIAS distributor, or contact BIAS directly. A
list of BIAS distributors may be found at:

http://www.bias-inc.com/distributors.html

BIAS Support Policy and Hours

BIAS, Inc. support policy and hours are subject to change
without notice.

Sales and Non-Technical Customer Service

For product information, sales, and other non-technical cus-
tomer service, please email or call:

sales@bias-inc.com

US: 1-800-775-BIAS (2427)

International: +1-707-782-1866

9AM-5PM Monday-Friday PST – excluding BIAS holidays

No technical support is available at the numbers or email
address above.

BIAS Product Support Options iv
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Chapter 1:
Introducing Peak Express

Welcome!

BIAS Peak Express is a streamlined edition of Peak – an
advanced audio application that provides superior tools for
editing and processing digital audio on the Macintosh com-
puter.  Peak Express was specifically designed to enhance
the audio tools built-in to Apple’s Final Cut Pro 4.  By com-
bining high-quality direct-from-disk digital audio editing fea-
tures with a lightning fast, completely non-destructive edit-
ing environment, Peak Express provides unique audio edit-
ing tools, and makes a superb addition to Final Cut Pro.

Peak Express Features:

•  Lightning-fast sample accurate audio editing

•  Pencil tool for sample level click removal

•  DV/QT clip import and playback w/ better-than-frame 
accuracy

• Supports DV standard 16 bit 48K playback

•  Core Audio compatible

•  Audio Unit & VST Plug-In Support* 

•  AIFF and QT audio file support

•  Zoom to Sample Level, Sample End, and Out All The 
Way

•  Magnifying Glass Precision Zoom Tool

•  Overview window

•  QuickTime Movie Window

•  Import CD Track(s)

•  Floating Cursor Palette

•  Fade In/Out

•  Change Gain

•  Convert Sample Rate

•  Normalize

•  Reverse

•  Mix

•  Gain Envelope

•  Insertion point at Selection End/Start

•  Time Unit display in SMPTE, Bars/beats, Min:Sec:ms

•  Silence

•  View in Clip Editor Support

•  Set Selection

•  Crop

•  Undo/Redo

•  Dual Mono Support

•  Toolbar

• Integrated Growable Transport, Meter, Info Display, 
Progress bar

•  Audio info window
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•  Play w/ Auditioning

•  Looping

*  The only VST format effects plug-ins supported by Peak 
Express are BIAS Freq2, BIAS Freq, BIAS SuperFreq & 
BIAS SoundSoap.

Minimum System Requirements

To use Peak Express - you will need:

•  G3 or G4 Apple Macintosh desktop, PowerBook, or 
iBook (≥ 200 MHz processor recommended)  

•  Macintosh OS 10.2 minimum

•  128 MB RAM minimum

•  20 MB available disk space

For most up-to-date info, see:

http://www.bias-inc.com/peakexpress/

Maximizing Peak Express Performance

•  Turn File Sharing off, unless you need it.

• Disconnect your Macintosh from any networks and
turn off AppleTalk, unless you need to be on a
network.

• Optimize your hard drive.

Core Audio

Peak Express allows you to use CoreAudio for playback.
Peak Express will play audio through the CoreAudio device
selected in the CoreAudio dialog.  CoreAudio has numerous
advantages over previous audio systems, including low
latency, shared drivers across applications, and support for
high bit-depths and sample rates.

About Your User’s Guide

Peak Express is designed to be simple and intuitive. Your
User’s Guide is designed to help you set up and use Peak
Express for digital editing as quickly and easily as possible.
This User’s Guide assumes that you are familiar with stan-
dard Macintosh operating techniques, including:

• Setting up, starting, and using your Macintosh

• Choosing commands from menus

• Double-clicking, selecting, Shift-selecting, and
dragging with the mouse

• Opening, copying, saving and deleting files

• Opening, closing, scrolling, moving, re-sizing, and
selecting Macintosh windows

If you don’t know how to perform these tasks, please refer
to your Macintosh User’s Guide and spend a little time
learning about your Macintosh before going any further.
This will make using Peak Express much easier and more
enjoyable.
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The Chapters in your Peak Express User’s Guide are
arranged in the order in which you would typically perform
tasks when embarking on an audio project:

• Chapter 1 introduces you to Peak Express and explains   
some of the requirements for using Peak Express soft-
ware

• Chapter 2 explains how to install Peak Express and con-
figure your Macintosh for audio playback

• Chapter 3 introduces you to some basic concepts of dig-
ital audio and disk-based recording, as well as basic Peak 
Express operations

•  Chapter 4 explains how to playback audio from hard disk 
in Peak Express using Apple Core Audio.  It also explains 
how to import audio from compatible CD-ROM drives

• Chapter 5 introduces you to the concepts and tech-
niques of non-destructive editing with Peak Express

• Chapter 6 is an overview of Peak Express’ powerful native 
DSP (Digital Signal Processing) tools

• Chapter 7 explains how to use Audio Unit and VST real-
time audio effects plug-ins

• Chapter 8 describes each command found in Peak 
Express menus

• Chapter 9 explains how to integrate Peak Express with 
Final Cut Pro as a dedicated external audio editor and 
gives examples of the workflow between the two appli-
cations

• Chapter 10 offers an overview of the wide array of other 
audio tools made by BIAS, should you choose to  
upgrade from Peak Express

Help

Peak Express’ Balloon Help will show you the functions of
each toolbar item as you move the mouse across different
toolbar icons.  If you hold the mouse cursor over a Toolbar
icon for 2 seconds, the Balloon Help for that icon’s function
will appear.

You can also use the Links menu to access BIAS documenta-
tion and technical support online.

Conclusion 

Now that you know a little about Peak Express, proceed to
the next chapter to learn how to install your software and
get started using it.

Look for important tips and notes whenever you
see this exclamation mark.
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Chapter 2:
Installing & Configuring
Peak Express

Installing Peak Express

Peak Express’ auto-installer software makes installation very
easy.

Your complete Peak Express system consists of:

• CD-ROM Installer

• Peak Express serial number and Product Authorization 
Code (PAC)

The Installer dialog 

To install Peak Express:

1.  If you are using any virus-protection software, turn it off 
or temporarily remove it, and restart your Macintosh.

2.  Insert the Peak Express Install CD-ROM in your CD-ROM 
drive, and double-click the Install icon.

3.  When the installer dialog appears, click the Continue 
button.

4.  Read the software license agreement

5.  Click Install at the bottom right of this dialog, and then 
click the Agree button.

6.  After you have clicked Install, follow the on-screen   
instructions.

7.  When the installation is complete, a message will appear 
indicating that the installation was successful.  Click Quit 
to quit the Installer (don’t forget to turn back on any 
virus-protection software that you may be using the next 
time you restart the computer).

What Peak Express Installs:

•  Peak Express automatically installs the Peak Express 
application into the following directory:

/Macintosh HD/Applications/

•  Peak Express automatically installs the BIAS SoundSoap 
demonstration version into the following directory:

/Macintosh HD/Users/<Your User Account>/Library/Audio/Plug-Ins/VST

At the end of installation, the installer will
give you the option of registering via the BIAS web-
site, which is the easiest way to register.        

Before you install Peak Express, please check the
Minimum System Requirements on Page 13 of this
User’s Guide.
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Making Audio Connections

While it is possible to listen to Peak Express using a
Macintosh’s built-in speaker or headphones, most people
will prefer to listen through a better quality external speaker
system.  It is very easy to set up audio connections between
your Macintosh and a mixer or speaker system.  Your exact
setup will differ slightly depending on whether you are using 
the built-in sound output connectors on your Macintosh, or
those of a third party audio interface.

Using the Macintosh’s Built-In Outputs

If you wish to use your Macintosh’s built-in audio
outputs for playback, do the following:

1. Turn down the volume on your playback system.
Peak Express can be used with a variety of playback
systems, including:

• headphones

• a stereo receiver or amplifier and speakers

• a mixer, amplifier, and a pair of speakers

• a mixer and a pair of amplified (self-powered) speakers

• or simply a pair of amplified (self-powered) speakers, 
smaller versions of which are often called “multimedia” 
speakers.

The Mac’s audio output jacks are standard stereo mini-plug
(1/8-inch) connector.  Most mixer, receiver, and amplified
speaker inputs are equipped with XLR, 1/4-inch, RCA, or
mini-plug jacks.  To make the proper connection, you may
need to use an adapter.

Authorization

Peak Express must be authorized to work on your comput-
er.  To authorize Peak Express, you will need your Peak
Express serial number and Product Authorization Code
(PAC).  These are located on the paper sleeve of the Peak
Express installer CD-ROM, included inside the Final Cut Pro
4 package.  

The Peak Express Authorization dialog

When you first launch Peak Express, it will prompt you to
authorize it by entering your Name, Organization, Serial
number, and Product Authorization Code.  (If you have filled
out your contact information in the Mac OS X Address Book
application, Peak Express will automatically fill out the con-
tact information section of the authorization window).

Be sure to register!  After you have installed Peak
Express, you can easily access BIAS’ online registra-
tion system by choosing “Register Peak Express” from
the Links menu

If you choose to store your Peak Express installer
CD-ROM in storage binder, etc. –  be sure to keep
the serial number and Product Authorization Code
that are located on the paper sleeve of the Peak
Express installer CD-ROM, as you will need these if
you ever need to re-install Peak Express.
Registering with BIAS ensures that these numbers
will always be accessible.      
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2. Connect your Mac’s audio output to your playback sys-
tem’s input.

3. Raise the volume on your mixer or playback system. Your 
system should now be properly configured and ready for 
playback.

Third-Party Audio Interfaces

If you have a CoreAudio-compatible PCI, PCMCIA
(CardBus), USB, or FireWire audio interface installed in your
computer and wish to use its outputs, do the following:

1. Turn down the volume on your mixer or playback sys-
tem.

2. Make sure that you have installed the third-party audio 
interface according to the manufacturer’s instructions.

3. Install the CoreAudio drivers for your audio interface 
according to the manufacturer’s instructions.

4. Connect the outputs of your audio interface to the       
inputs of your mixer or playback system.

5. Raise the volume on your mixer or playback system. Your 
system should now be properly configured and ready for 
playback.

CoreAudio

Peak Express can use CoreAudio – If you want to use a
CoreAudio-compatible third-party audio interface with Peak
Express, install the CoreAudio driver for the interface, and
launch Peak Express. Be sure to consult the manufacturer’s
instructions when installing your audio interface. For more
detail on using Peak Express with a CoreAudio-compatible
audio interface, please read Chapter 4: Playing back Audio.

USB and FireWire Audio Interfaces

Mac OS X v.10.2.3 or later supports USB Audio on iMacs,
iBooks, B/W G3s, and G4s.  Peak Express supports USB
audio with interfaces such as the Tascam US-428, and M-
Audio Duo.  Peak Express also supports compatible FireWire
audio interfaces, such as the MOTU-828.

Conclusion

Now that you have installed Peak Express, and installed and
configured any third-party audio interface and its drivers,
proceed to the next chapter to learn several basic concepts
and functions essential to using Peak Express.

A typical mixer/computer configuration is to
have the computer outputs go to channel
inputs on your mixer. The mixer’s main
outputs go to the amplifier/speakers.
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Chapter 3:
Peak Express Basics

Introduction

This chapter explains several key Peak Express concepts and
functions, including how to open, close, and save audio doc-
uments.

A Brief Explanation of Digital Audio

If you are new to digital hard-disk-based recording, you may
wish to acquaint yourself with a few of the principles behind
digital audio before you dive into using Peak Express soft-
ware. This section explains a few key concepts that will give
you a good general understanding of how Peak Express
does what it does.  What we hear as sound is actually a pat-
tern of pressure waves that move through the air. The fre-
quency of these waves determines the pitch of the sound —
how low or high it sounds. Sound frequency is measured in
cycles per second, or Hertz (Hz). The range of human hear-
ing is generally considered to be from about 20 Hz at the low
end to 20 kHz at the high end. In practice, however, most
adults hear only as high as 12 kHz to 18 kHz, especially those
of us who may have spent more time than we should have
with headphones or at loud rock concerts.

Sampling and Sample Rate

Your Peak Express software-equipped Macintosh computer
stores audio digitally. This means that analog electrical sig-
nals from microphones or other sources are converted into
numbers by a circuit called an analog-to-digital converter
and stored on hard disk. The analog-to-digital (A/D) con-
verter uses a technique called digital sampling to convert
analog electrical signals into numbers.

Digital sampling is the sonic equivalent of taking a snap-

shot.  By taking thousands of little digital samples per sec-
ond and storing them to a hard drive, an A/D converter can
capture an accurate sample-by-sample representation of a
sound, much like a movie is a frame-by-frame representation
of a moving image. The number of samples taken of the
audio in a second is called the sample rate.  The sample rate
determines the recording’s upper frequency response. A
higher sample rate delivers higher frequency response. As a
rule of thumb, a digital recording’s upper frequency
response is roughly half of its sample rate (known as the
Nyquist frequency). The audio on compact discs, for exam-
ple, is recorded at 44,100 samples each second, or 44.1 kHz.
This sample rate is the standard for professional-quality dig-
ital audio, and provides an upper-end frequency response of
approximately half the sample rate (known as the Nyquist
frequency): 22.5 kHz, somewhat higher than most people’s
hearing range.

Bit Resolution

Another factor that affects the quality of the audio is the res-
olution of each sample. The greater the resolution, the bet-
ter the quality. To use an analogy from the film world, just as
image resolution and quality increase with film size (8 mil-
limeter film is much lower in image quality than 70 millime-
ter film) greater bit resolution (8-bit, 16-bit, 24-bit, and 32-
bit) results in better fidelity digital audio. Audio CDs have a
resolution of 16-bits.

In practice, the bit resolution determines the recording’s
dynamic range—that is, how many distinct steps you have to
describe a sound’s level, from quiet to loud. For instance, an
8-bit recording has 256 (28) levels available, which is the
equivalent of 48 decibels (dB) of dynamic range. On the
other hand, a 16-bit recording has 65,536 (216) levels avail-
able, equivalent to 96 dB dynamic range. (The rule of thumb
for determining the dynamic range in decibels is to take
the bit rate and multiply it by 6.)



Hard Disk Storage Requirements

The actual recording of audio to hard disk requires a signif-
icant amount of storage. This is directly affected by the sam-
ple rate and bit resolution at which you record: the higher
the fidelity, the greater the requirements for storage. As a
guideline, 16-bit, 44.1 kHz audio requires roughly 5
megabytes of storage per minute of mono recording. Stereo
16-bit, 44.1 kHz audio requires roughly 10 megabytes per
minute. Stereo 24-bit, 44.1 kHz audio requires roughly15
megabytes per minute.

Hard Disk Maintenance

Because audio playback is a hard disk intensive task, it is
important that your hard drive be in good operating condi-
tion. In the computer world, this means keeping it from
becoming fragmented by using hard drive maintenance soft-
ware. Fragmentation occurs as your hard drive begins to run
out of contiguous (uninterrupted) space where it can write
files. If the data that makes up a file is stored at a single loca-
tion on your drive, it is much easier and faster for your drive
to find the data and read it.  However, as contiguous space
runs out, the drive may not be able to write the entire file in
one location and instead must fragment the file by writing
pieces of it at various locations in whatever smaller open
areas it can find. This requires that the drive search near and
far to read the pieces of the file. Too much fragmentation
can lead to errors in recording and playback as the hard
drive struggles to keep up with the demands of your audio
application.

In general, you should keep your hard disk below 10% frag-
mentation. Most hard drive maintenance software packages
let you monitor the degree of fragmentation on your drive
and defragment it by rewriting files into contiguous blocks
of data.   In addition to defragmenting your drive regularly,
you should also back up your files and reformat  your drive
on a regular basis to keep your system in top operating
condition.  condition. By doing this, you will ensure maxi-
mum performance from your Macintosh and Peak Express
software and keep your studio running smoothly.
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About Disk-Based Editing

If you are new to hard-disk-based editing, you will be
impressed by the power and control that Peak Express soft-
ware provides for editing digital audio. You will encounter
several new concepts and techniques for using a disk-based
system such as Peak Express.  Perhaps the most important
among these is the concept of nondestructive manipulation
of audio.

Nonlinear Versus Linear Editing

Nondestructive audio manipulation is possible thanks to the
nature of Peak Express’ editing medium: a hard disk instead
of a roll of analog tape. Unlike analog tape, which is a linear
medium, hard disks provide a nonlinear, or random-access
medium. This is because audio is stored on hard disk as dig-
ital information which the hard disk can access immediately
or randomly (hence the term “random-access”), simply by
moving its read/write head to the appropriate location and
reading the appropriate data. This allows you to perform
such miraculous feats as cutting and pasting “pieces of
sound” and rearranging material long after it has been
recorded.

Nondestructive Editing

Perhaps most impressive is the fact that with disk-based
audio production you need not actually modify the original
source material in any way to accomplish these feats. In
most cases, by cutting and pasting you are in reality only ask-
ing the hard disk to access portions of the audio file in a
slightly different order.  Since Peak Express doesn’t normal-
ly cut up, move around, or delete the actual recording on
the hard drive, it’s said to be a nondestructive editing sys-
tem. Peak Express does not rewrite the file until you choose
to save your edits.  Other manipulations, such as playing
audio material backwards, can be accomplished by reading
the data in reverse order. The power and flexibility of disk-
based audio production software such as Peak Express far
surpasses the capabilities of traditional analog audio
production tools.
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Now that you understand some of the basic principles
behind digital audio and disk-based editing, take a few
moments to learn some of the basic operations of Peak
Express.  These are covered in the sections that follow.

First, we’ll take a look at the Graphical User Interface, or
“GUI”, and then at some of Peak Express’ basic functions.

Toolbar

Clip Indicators

Transport
Controlds

db Scale

File Overview

Cursor Palette

VST Plug-In

Counter

VU Meters

Loop Markers

Audio Info Area

Audio Waveform

Selected Waveform

Detail Area

Peak Express
Graphical User Interface (GUI)

Audio Unit Plug-In

QuickTime Movie Window
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Creating a New Peak Express Document

Peak Express will allow you to create an empty audio file of
zero duration by choosing a new mono or stereo document.
However, you would typically open an existing audio file into
Peak Express for editing.  Peak Express allows you to have up
to two audio documents open at the same time.

To create a new audio document:

• Choose New (a-N) from the File menu or Toolbar.  This 
command provides a hierarchical menu which allows you 
to choose either a mono or stereo format for the new   

Creating a new Peak Express document

Opening Existing Audio Documents

Peak Express allows you to open audio files created in a vari-
ety of common audio formats including AIFF, WAVE,
QuickTime.

Opening WAVE files

The Macintosh recognizes files using a “type” and “creator.”
WAVE files are recognized by some audio applications with a
type “.WAV,” while others recognize only “WAVE” as the type.
Peak Express, along with Apple’s QuickTime software and
most other Multimedia applications, recognize WAVE files of
the type “WAVE,” but not of type “.WAV”.   You can use
ResEdit or other third-party applications to ensure your
WAVE files

have the correct type prior to opening them with Peak
Express.

To open an audio file:

1.  Choose Open (a-O) from the File menu.

2.  In the dialog that appears, locate the file that you wish  
to open. From this dialog, you can open AIFF, WAVE, 

or QuickTime audio files.

3.  When you find the file you wish to open, click the Open 
button and Peak Express will open the audio file into a 
new audio window, displaying an overview of the entire 
sound.  Shift-click or a-click to open multiple files.

Creating a new Peak document
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Recently Opened Documents

Peak Express automatically remembers up to the last eight
audio documents that you have opened and keeps a list of
these at the bottom of the File dialog. This allows you to eas-
ily select a document’s name and re-open it without having
to search on your hard drive.  Peak Express can find and
open a document even if you have changed its location on
your hard drive. If you change the name of the file, the next
time you open Peak Express, it will automatically update the
name in its internal list.

Recently opened documents in the File menu

Opening “Dual Mono” Files

Certain audio applications, such as BIAS Deck, use “dual
mono” files, which comprise the right and left channels of
stereo material.  Peak Express allows you to open such dual
mono files, and in the process creates a new interleaved
stereo audio document. Because Peak Express actually
writes a new stereo audio file to disk, this conversion
process requires hard disk space equivalent to the two orig-

inal mono files.

To open a dual mono file:

1.  Make sure the “Auto Import Dual Mono” preference is 
checked under the Preferences menu.

2.  From the File menu, choose Open, and locate the 
desired files.

3.  Select either half of the dual mono file and click Open. 
Peak Express imports both halves of the dual mono file.

4.  When Peak Express has finished creating the new stereo 
audio document you can begin editing.

Peak Express also allows you to export your stereo audio
documents in Dual Mono format, which means that it’s easy
to import dual mono tracks from BIAS Deck into Peak
Express, edit and process them within Peak Express, and
then export them as Dual Mono files to be reincorporated
into your Deck sessions.

Please note that the Import Dual Mono
command requires that both files be mono files
and have the same sample rate.

Please note that these dual mono files must have
exactly the same file name with the suffix “.L” for
the left channel and “.R” for the right channel.
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CD Audio Tracks

Peak Express allows you to drag a CD audio track directly
onto the Peak Express icon or open the track directly from
the Open command under the File menu or Toolbar.  When
you import a CD track using one of these two methods, the
entire track will be imported. If you do not want to import
an entire audio track, you can still use the Import CD track
command under the File menu (covered in Chapter 4).

Saving and Closing Documents

It is good practice to save regularly throughout a project to
avoid losing valuable work in the event of a power failure or
other unfortunate occurrence.  The Save command saves
the changes you have made to your audio document by writ-
ing it to your hard disk.  The Save command cannot be
undone.  If you want to be able to continue to undo your
edits, use the Save a Copy As command under the file menu.
Peak Express allows you to save your audio documents in a
variety of common audio file formats, each of which is
described below. Be aware that different formats allow dif-
ferent information to be stored with the file. Peak Express
preserves this information unless you save the file into a dif-
ferent file format. Saving a file in a format different from its
original format may, however, cause some information
stored in the file to be discarded.  Peak Express supports the
following audio file formats:

•  AIFF: This is Apple’s Audio Interchange File Format. It is 
also Peak Express’ default file format and is supported 
by many Macintosh software applications.

•  WAVE: This is Microsoft’s Windows Audio File Format. It 
is supported by many Windows software applications 
and some Macintosh applications. The WAVE format is 
best if you plan to use an audio document in an appli-
cation that supports or requires WAVE format files.

• QuickTime: This is Apple’s audio file format for 
QuickTime-based multimedia. It is supported by all 
Macintosh software applications that support 

QuickTime. The QuickTime format is best if you
plan to use an audio document in multimedia applica
tions that support QuickTime, such as Macromedia 
Director™.

To save a Peak Express document:

1.  Choose Save from the File menu or press a-S on your 
keyboard.

2.  Select a file format from the pop-up File Type menu. 
AIFF is Peak Express’ default audio file format.

3.  Enter a name for the new audio document, select  where    
you want to save the new file, and then click Save.

Using the Save As... and Save A Copy As... Commands

The Save As command allows you to save a copy of the cur-
rent document under a different name, or in a different loca-
tion on your hard disk. Since the Save As command closes
the current document and lets you keep working on the
renamed copy, it is useful for saving successive stages of a
project. This allows you to save each major step under a dif-
ferent name. Later you can retrace your steps should you
want to go back to an earlier version. The Save A Copy As
command will save a copy of the file you are working on, but
it will keep the copy you are working on open. This allows
you to continue working on your audio and still be able to
undo any edits you executed prior to using the Save A Copy
As command.

To save an audio document under another name:

1.  Choose Save As (Shift-a-S) or Save A Copy As (Option-
a-S) from the File menu. The Save dialog appears.
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2.  Select the desired file format from the File Type pop-up 
menu. AIFF is Peak Express’ default audio file format.

3.  If you wish to save the audio document to a different bit 
depth resolution, click the bit depth pop-up. 

4.  Enter a name for the new audio document, select where 
you want to save the new file, and click Save.

The Save dialog

Closing Audio Documents

To close a file in Peak Express, choose Close from the File
menu (a-W ). If you have made any changes to your docu-
ment since the last time you saved, Peak Express will ask you
if you want to save them. If you do, choose Yes; if you do
not, choose No. If you change your mind and wish to con-
tinue your session, choose Cancel.  To close all files current-
ly open in Peak Express, choose Close All from the File menu
(a-Option-W ).

Peak Express Windows and Palettes

There are several windows and palettes when you open Peak
Express that either appear by default or are available to you
under Peak Express’ Windows menu.  Windows that appear
in Peak Express by default include an audio document win-
dow for each audio file you have open. Windows and pallettes

that you can turn on or off include the Transport, the
Toolbar, the Cursor Palette, and the Movie Window.  This
section will cover the basic function of these Peak Express
Windows and Palettes.

Peak Express Audio Document Window

Peak Express Audio Document windows contain a Waveform
Display, an Audio File Info Bar and a Max Level Indicator in
the lower left corner. The Waveform Display is a graphic rep-
resentation of the audio file, the Audio File Info Bar shows
the sample rate, bit resolution, file format and file size of the
audio file, and the Max Level Indicator shows the highest
amplitude level in the audio file. On top of the Audio
Document window is the File Overview, if it is enabled 

The Audio Document window

under the Peak Express Preference menu. The Audio
Window is described in more detail in Chapter 5.

Transport Window

The Transport window is a floating, re-sizable window.  It
contains three areas: a time display showing elapsed time,
the Transport controls (Return to Zero, Stop, Play, Go to
End, and Loop during playback), and audio level meters
with clip/peak indicators.

Transport window
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Palette. To change the cursor tool, click on a new icon. 

The Peak Express Cursor Palette

Arrow Cursor Tool

The Cursor Tool is the default tool. It is the standard “arrow”
tool that lets you click and select on-screen items.

Hand Tool

The Hand Tool lets you grab and move a waveform around
in its window.

Magnifying Glass (“Zoom Tool”)

To use the Magnifying Glass tool, simply click on the tool in
the Cursor Palette, then move the cursor over the waveform.
A “plus” (+) sign will appear inside the Magnifying Glass.
Click on the waveform to zoom in; each click of the mouse
will zoom in farther. To zoom out, option-click on the wave-
form. A “minus” (-) sign will appear in the Magnifying Glass,
and you can click on the waveform to zoom out. Double-
clicking on the Magnifying Glass will open the Zoom
Amount dialog where you can specify the Zoom Amount.

The Zoom Amount dialog

Time Display

The Time Display is like a counter. It shows elapsed time and
tracks the “playback head” as audio plays.  Clicking on the
waveform when playback is stopped will cause the current
cursor location to appear in the Time Display. This display
will also show the time remaining while performing Open,
Save or DSP processing actions.

Meters

Peak Express’ meters are much like the VU or LED meters on
a mixing board or tape recorder. They are bar graph meters
that show the relative volume or loudness of the audio as it
plays. They are also designed to show peak volume and
whether the signal has “clipped,” or distorted.

Progress Bar

The Meters display changes to a progress bar during audio
processing, and while saving or opening audio files.

Progress bar

Cursor Palette

Peak Express has a floating Cursor Palette that contains sev-
eral useful functions. Along the top right side of the palette
are four different icons representing different cursor modes.
The default cursor is a standard Arrow Cursor.  You can also
use the cursor palette to select a Hand Cursor for moving a
waveform within its window, a Pencil Tool for drawing direct-
ly on the waveform at the sample level, and a Magnifying
Glass Tool for zooming the waveform view in and out. The
ESC key on your computer keyboard will toggle through the
four cursor modes.   To access any of these cursors or func-
tions, just click on the corresponding icon in the Cursor 
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[R] = the cursor is currently positioned over the
right channel of the audio

DTR = distance in the currently specified time units
(Samples, Min:Sec:ms, SMPTE, or Bars|Beats) to the 
nearest reference marker

Sel = the duration of the current selection in the cur
rently specified time units (Samples, Min:Sec:ms, 
SMPTE, or Bars|Beats)

“+” or “–”  indicates positive or negative phase 

BPM = beats per minute

The time format displayed in this field depends on which
time format (Samples, Min:Sec:ms, SMPTE, or Bars|Beats)
you have chosen with the Time Units command under the
Preference menu.

Pencil Tool

The Pencil Tool lets you draw directly on the waveform at
the sample level. This is very useful for drawing out clicks in 

The Draw Tool dialog

the waveform. Double-click on the Pencil Tool icon in the
Cursor Palette for the Drawing Tool Smoothing Settings.

Cursor and Selection Information

The bottom half of the Cursor palette displays the X (time)
and Y (amplitude) coordinates of the cursor point, Sel: the
duration of any currently selected audio), DTR (Distance to
Reference Marker), and BPM: the tempo in beats per
minute. You can type a value in for the X, Sel, and BPM
parameters.  Here is how to read the cursor and selection
information that appears in the Cursor Location display.

Y = the current cursor position along the vertical scale 
(amplitude) or start point of a selection

X = the current cursor position in the currently speci
fied time units (Samples, Min:Sec:ms, SMPTE, or 
Bars|Beats)

[L] = the cursor is currently positioned over the left
channel of the audio
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Setting Peak Express’ Playback Parameters

Peak Express’ Playback Preferences dialog allows you to con-
trol the master output volume, hard disk playback buffer
size, and window buffer size.

Peak Express Playback Preferences dialog

Playback Master Volume

Peak Express provides a master volume control for audio
playback. In the Playback Preferences dialog, set Peak
Express’ output volume to the level that you desire by
adjusting the slider or entering a number value from 0
(silent) to 7 (loudest).  If you are controlling your playback
volume with the volume control of your playback system,
you’ll probably want to leave the output level set to 7.

Playback Buffer

Peak Express allows you to control the amount of RAM the
program uses when playing back audio documents. In gen-
eral, lower is better. A playback buffer of 32k is a good place
to start. If you are experiencing clicks in your playback,
working with fragmented files, using processor-intensive
real-time DSP, or are using a slow hard drive, you may need
a larger playback buffer setting.

Setting Preferences

You can customize a number of Peak Express’ parameters so
you can work with the program in a way that best suits you.
Most of these parameters are found in the Preference menu.
These include the controls for playing back audio docu-
ments, the selection of the icons in the Toolbar, and the col-
ors that you want for the audio document window. Once
you have set these preferences as you like, they will stay that
way until you decide to change them again. This section
explains how to set several of these parameters. For any
menu items not covered here, please refer to Chapter 8:
Peak Express Menus. There you will find explanations of
each command in the Preference menu and other Peak
Express menus. Items from the Preference menu are also
covered throughout this manual where their discussion is
relevant.

The Preference menu
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Scroll During Playback

With the Scroll During Playback command enabled, Peak
Express will “scroll” through the audio document as play-
back progresses. This allows you to visually follow the
progress of audio playback. A check next to this menu item
indicates that it is enabled.

To enable Scroll During Playback:

1.  Select Scroll During Play from the Preference menu. A 
check next to this item indicates it is enabled.

2.  To disable Scroll During Playback, simply re-select Scroll 
During Play from the Preference menu.  The absence of 
a check next to this item indicates it is disabled.

Move Waveform During Playback

With the Move Waveform During Play command enabled,
Peak Express will move the waveform under the cursor as
playback progresses, so that the playbar is always in the mid-
dle of the waveform display.  A check next to this menu item
indicates that it is enabled.  

To enable Move Waveform During Playback:

1.  Select Move Waveform During Play from the Preference 
menu. A check next to this item indicates it is enabled.

2.  To disable Move Waveform During Playback, simply re-
select Move Waveform During Play from the Preference 

menu. The absence of a check next to this item indicates 
it is disabled.

Auditioning

Peak Express’ Auditioning command allows you to audition
a selection along with a specific amount of audio preceding
or following it. The Auditioning dialog allows you to select a 

Window Buffer

Peak Express also allows you to control the amount of RAM
the program uses to cache audio data and the size of each
processing chunk. Use larger values if you are working with
a few large files, and smaller values if you are working with
smaller files.

Dynamic Scrub Time

Peak Express provides a unique audio auditioning technique
called dynamic scrubbing. This feature is very useful for pre-
cisely pinpointing and selecting a desired location in an
audio document. Dynamic scrubbing allows you to drag the
mouse forward or backward over a waveform while Peak
Express plays a short loop (between 10 and 600 millisec-
onds) at the scrub location. When you have found the loca-
tion you are looking for, let go of the mouse and the inser-
tion point will be exactly where you want it to be. Peak
Express allows you to choose the length of this playback
loop with the Dynamic Scrub Time command in the
Preference menu. You can also select Tape-Style Scrubbing
in this dialog. For a full description of scrubbing audio in
Peak Express, please see Chapter 5.  

To select a loop duration for dynamic scrubbing:

1.  Choose Dynamic Scrub Time from the Preference menu, 
and choose a duration from the hierarchical submenu. 
Typically, a value of between 40 to 80 milliseconds works 
well.

2.  You can also select Tape-Style Scrubbing by selecting it 
in this submenu. To deselect Tape-Style Scrubbing, just 

click any duration value in the submenu.

To use Tape-Style scrubbing, you must select “Mac
OS X Audio HAL” from Peak Express’ Audio
menu>Sound Out submenu.
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desired amount of pre-roll or post-roll when you play the
selection. To play a selection with the selected amount of
pre- and postroll, press Control-Spacebar.

To configure Auditioning:

•  Select Auditioning from the Preference menu. Enter the 
desired amount of Pre-roll and Post-roll into the dialog 
boxes. Click OK to exit the dialog.

The Auditioning dialog

Auto-Import Dual Mono

Certain audio applications, such as BIAS Deck and
Digidesign’s Pro Tools, do not directly support interleaved
stereo files, and instead use “dual mono” files–a pair of files,
one for the left channel and one for the right channel. These
files have typically been exported with the suffix “.L” for the
left channel, and the suffix “.R” for the right channel. Auto-
Import Dual Mono, when selected, will allow you to select
just one channel of the dual mono file in the Open dialog.
Peak Express will automatically “grab” the other half of the
file, and convert both files into a single stereo Peak Express
document.

To enable Auto-Import Dual Mono:

1. Select Auto-Import Dual Mono from the Preference 
menu. A check next to this item indicates it is enabled.

2.  To disable Auto-Import Dual Mono, simply reselect Auto-
Import Dual Mono from the Preference menu. The 
absence of a check next to this item indicates it is dis-  
abled.

Choosing a Time Format

The Units command allows you to choose a time format for
the audio timeline in Peak Express’ audio document win-
dow. You can choose samples, seconds, SMPTE frames, and
Bars|Beats. The format you choose will depend on the
nature of the project that you are working on.

To choose time format:

1.  Choose Time Units from the Preference menu.

2. From the submenu, choose the time format that you 
desire: samples, Min:Sec:ms, SMPTE frames, or 
Bars|Beats. The timeline in Peak’s audio document win-
dow and Transport switches to the format that you 
choose.

Choosing a time format with the Units command

Audio File Meter, Tempo, and Timestamp Settings

If your audio document is using bars |beats as its units,
you will want to tell Peak Express what the tempo of the

Please note that the Import Dual Mono
command requires that both files be mono
files, have the same sample rate and bit depth,
and the must have the exact same name
followed by the suffixes “.L” and “.R”.
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audio document is. Use the Audio Info command from the
Preference menu — or enter the BPM in the Cursor palette
— to set the tempo of the audio document. You can also
enter the meter of an audio document using the Audio Info
dialog. The numerator represents the number of beats per
measure, and the denominator represents the value of a
beat, where 4=quarter note, 8=eight note, 16=sixteenth
note, and so forth.

Audio Document Info

You may also enter a timestamp for the audio document in
seconds. If the audio document has a timestamp, then the
displayed time in an audio document will be offset from this
time rather than starting at zero. For example, if the time-
stamp for an audio document is four seconds, then the first
sample in the audio document will appear in the audio doc-
ument with a time of 4 seconds instead of zero seconds.

Choosing a Scratch Disk

Because audio data can be very large, Peak Express utilizes
a portion of your hard disk’s free space to hold audio data
that has been cut or copied, as well as for temporary or
scratch files for undo purposes. If your hard disk is short
on space, you may not be able to cut, copy, or modify large
selections. If you have more than one hard drive attached
to your Macintosh, the Scratch Disks command in the
Preference menu allows default, or “Primary” disk for this
purpose – usually you  the most free space.

If you are connected to a file server, you can utilize avail-
able storage on the server by clicking the Allow Servers
checkbox. Any available servers will then appear in the
Scratch Disks pop-up menu. This feature is recommended
only if you have access to a high speed Ethernet, Media
Net, or other fast server.

To choose a scratch disk for temporary files:

1.  Choose Scratch Disks from the Preference menu, The 
Scratch Disks dialog appears.

The Scratch Disks dialog

2. The Scratch Disks dialog will show all hard drives cur-
rently connected to your Macintosh. Choose the hard- 
drive(s) that you wish Peak Express to use when it cre
ates temporary files by clicking the checkboxes next to 
the drives in the list. To choose the Primary Disk, or the 
default disk for temporary files, click on the Primary 
button next to that disk.  If you are connected to a file 
server and would like to use storage available there as 
well, enable the Allow Servers checkbox.

3. Click OK to close this dialog.  Peak Express will 
use the disk you have selected as your Primary 
scratch disk, and, if  it becomes full, will then use the  
other disks you’ve chosen.
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The Toolbar

Peak Express allows you to select many useful commands
from the Toolbar.  The Toolbar is an easy way to make your
work in Peak faster and more efficient.

Quitting Peak Express 

When you have finished a project or wish to end an editing
session, the Quit command allows you to quit Peak Express
and return to the Finder.  If you haven’t saved changes, Peak
Express will warn you before allowing you to quit.

To quit Peak Express:

• Choose Quit from the Peak Express menu (a-Q).

If you have made any changes to your document since the
last time you saved, Peak Express will ask you if you want to
save them.  If you do, choose Yes; if you don’t, choose No.  If
you change your mind and wish to continue your session,
choose Cancel.

The hard drive with the original audio file
must have the equivalent amount of free space
(i.e., a 60MB file would require that there be an
additional 60MB of free space on the hard drive
on which the file resides).  You must have write
permissions for the selected Scratch Folders and
Disks or else Peak will report an error. Contact
your System Administrator if you need assistance
changing Directory or Disk permissions.

Conclusion

You now know how to create, open, import audio files,
export, close, and save Peak Express documents. You also
know how to set the preferences for operating Peak Express.
The next chapter explains how to use your Peak software to
play back audio files from disk.

If you wish to close all currently open windows
without saving, hold down the Option key and
click Don’t Save.
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Chapter 4:
Playing Audio

In this chapter you’ll learn how to play back audio with Peak
Express.  If your Macintosh is equipped with a CD-ROM
drive, you can also import audio directly from an audio CD. 

Mac OS X Audio HAL is the Apple Sound Manager on OS X.
If you are running Peak Express on OS X, select FireWire DV
to use any supported Digital Video (DV ) device—such as a
camcorder—connected to a FireWire port, Mac OS X Audio
HAL (System) to use the Macintosh Built-In Sound, or Mac
OS X Audio HAL to use the audio device which is selected
for output in the Sound System Preferences.

CoreAudio

Peak Express supports CoreAudio under OS X.  CoreAudio
can be used with the Built-In Sound on your Macintosh, or
with any third-party audio interface that has support
CoreAudio drivers. If you have a third party audio interface,
install its CoreAudio driver according to the manufacturer’s
instructions (for example, the M-Audio Duo series). Be sure
to reboot your computer after installing any new CoreAudio
driver software. If the audio interface has its own utility or
configuration software, be sure to configure it prior to
launching Peak Express.

The Sound Out submenu under the Audio menu

Playback with CoreAudio

To use Peak Express with Core Audio:

1. If applicable, install your third-party audio interface 
and its software according to the manufacturer’s 
instructions.

2.  Reboot your Macintosh under OS X.

3.  Launch the OS X System Preferences, and choose 
Sound.

System Preferences Sound Output

4.  Select “Built-in audio controller”  ( or your third-party 
audio interface) for Output.

5.  Configure the audio interface’s own utility software or 
control panel (if applicable).
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Hardware Settings: M-Audio Duo Control Panel

6.  Launch Peak Express.

7.  Choose CoreAudio from the Sound Out submenu    
under the Audio menu.

8. Select the Clock Source, Sample Rate, and Play 
Through outputs in the CoreAudio Playback dialog.  
Click OK, or for further options, click the More button.

CoreAudio Playback dialog

9. Select the Input Device, Output Device, and Buffer 
Size. Click OK to close the CoreAudio Settings dialog 
and click OK again to close the CoreAudio Playback dia-
log.

CoreAudio Settings

Peak Express is now configured for playback with CoreAudio.

Playing Audio with Peak Express

Once you have configured Peak Express for Playback using
CoreAudio, you can start to playback audio with Peak
Express.

The Transport Controls

The Transport Controls that appear in the Transport window
are useful tools for initiating playback and controlling navi-
gation within an audio document.  They function much as
the controls on a tape recorder would. As they appear
below, from left to right, they are Return to Zero, Stop, Play,
and Go to End.

The Transport Controls

To start playback from the beginning of a document:

1. Press the Spacebar, or click the Play button in the 
Transport. Playback begins from the beginning of the 
document.

2.  To stop playback, press the Spacebar again or click the 
Stop button in the Transport.

To rewind playback to the beginning of a document:

•  Click the Stop button twice, or click the Rewind button 
in the Transport. You can also press the Return key if 
playback has been stopped.

To start playback from a specific point in a document:

1. Click the cursor at the desired location in the audio 
document and press the Spacebar on your computer key-

board.  Playback begins from the cursor location and 
continues to the end of the document.
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2. Alternatively, double-click the mouse at the desired 
location in the audio document. Playback begins from 
the location that you double-clicked and continues to 
the end of the document.

3. You can also click anywhere in the Audio Waveform 
Overview to begin playback from that point.

4.  To stop playback, press the Spacebar.

Triggering Playback of Multiple Audio Documents

Peak Express allows you to have two audio documents open
at a time.  Peak Express assigns each of these documents a
number based on the order in which it was opened.  Peak
Express provides you with a convenient way of triggering
playback of any open audio document by pressing a number
key on your computer keyboard.  This is an easy way to trig-
ger playback of each audio document – pressing the “1” key
on your keyboard will start playback of the first document
that was opened, and pressing “2” will start playback of the
second document opened.

To trigger sequential playback of multiple audio documents:

1. Open two audio documents, taking note of the 
number that Peak Express assigns them in the 
Windows menu. (This is based on the order in which 
the documents were opened.)

2. Press the number which corresponds to the docu-
ment(s) you wish to play. (Note: the numeric keypad 
will not work for this function, you must use the num-
bers at the top of the keyboard). You don’t need to 
wait until a document has finished playing to press the 
next number: typing a numerical sequence on your 
keyboard will “cue up” both of the corresponding files. 

They will then play in the order you choose.

3. If you wish to stop playback and jump to the next

document in line, press the Return key.  Peak Express 
initiates playback of the next document in sequence.

Importing a Track From an Audio CD
(CD Audio Extraction)

If you own a Macintosh computer that is equipped with a
compatible CD-ROM drive, you can use Peak Express to
import audio directly from an audio CD.  This process is
sometimes referred to among multimedia developers as
audio extraction, or audio-across-SCSI. If you own an Apple
or non-Apple external CD-ROM drive, you may also be able
to take advantage of this feature.

Please note that not every CD-ROM drive supports audio
extraction, and that even among drives of the same model,
one drive’s firmware (the internal operating software) may
support audio extraction, while another’s may not. If you are
unsure as to whether or not your drive supports Apple-stan-
dard audio extraction, your best bet is to try the instructions
that follow.  If this doesn’t work, please contact the CD-ROM
drive’s manufacturer to establish whether your drive (and
your drive’s firmware) will support Apple-standard audio
extraction.

To import tracks from an audio CD:

1.  Insert an audio CD in your CD-ROM drive.

2.  Choose Import CD Track from the File menu or click 
the CD button in the Toolbar.

3.  In the dialog that appears, select the CD track that you 
wish to import and click Mark.  You may mark multiple 
tracks for import.  If you wish to import all of the 
tracks on the CD, click on the Mark All button.

4.  To name a selected CD track, click the Track Name but-
ton.  If you have iTunes installed and are connected to 
the internet, Peak Express will recognize the track
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names by their ISRC codes as they are registered on 
the CDDB™ online CD database.

Import CD Audio dialog

5.  Check the Open tracks after importing checkbox if you 
want the CD track(s) you are importing to open in 
Peak Express.  If you prefer to import the CD track(s) 
straight to disk, be sure to deselect the Open tracks 
after import checkbox.

6.  Click the Import button in the Import CD Audio dialog 
to import the selected tracks and the Save dialog 
appears.  Use the pop-up menu at the top of the dia-
log to navigate to the hard drive where you wish to 
save the audio file. Click Save to save the file to disk. 
Peak Express will save the file(s) in the AIFF audio for -
mat.

Conclusion

You have now learned how to playback audio from hard disk
using the Apple CoreAudio system.  You have also learned
how to import audio tracks from CDs. In the next chapter,
you will learn how to edit audio with Peak Express’ powerful
set of digital editing tools.



Chapter 5
Editing
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Chapter 5:
Editing

This chapter introduces you to the concept of digital audio
editing. You will learn how to do digital audio editing with
Peak Express’ many powerful digital editing tools.

Editing Audio with Peak Express

Peak Express provides you with a powerful interactive, non-
destructive environment for editing and manipulating audio.
In this environment, not only are virtually all editing actions
completely “undo-able” and “redo-able,” but they can be
performed interactively while audio playback is engaged.

Interactive Editing

Interactive editing means that you can cut, paste, loop, and
process audio with DSP functions and Plug-Ins even while
playing back the very audio that you are editing.  For exam-
ple, you can start playback, cut a selection of audio and paste
or insert it later in the document, and when Peak Express
reaches the location of the inserted audio, it will play it as if
it were there all along.  This revolutionary capability makes
Peak Express a supremely fast and flexible audio production
tool that makes conventional recording and editing meth-
ods, such as analog tape and a razor blade or Sound
Designer, seem primitive and archaic by comparison.

Nondestructive Editing

Peak Express’ nondestructive editing capabilities mean that
the edits you perform to an audio document do not perma-
nently change the original source recording until you finally
save the document. Thus, you can cut, copy, paste, fade in
and out of, and otherwise completely change a recording,
and still be able to return back to square one — the original
untouched state of the recording — up until the time that 

you save the document to disk.  At that time, all edits are
permanently written into the document.

Undo and Redo

As an editing session progresses, Peak Express maintains an
internal list of the edits that you perform.  Changes that you
make to an audio document are not permanently applied to
the file until you ultimately save it.  Peak Express allows up
to 5 levels of Undo and Redo.  Through the use of the
Macintosh’s standard Undo and Redo commands, you can
undo or redo your actions sequentially.  This is a very excit-
ing technology that allows you to maintain complete cre-
ative freedom of choice — right up until the last moment
before you save your project to disk.

The Audio Document Window

The heart of Peak Express’ powerful editing capabilities is
the audio document window. The audio document window
provides you with a “window into sound,” allowing you to
make good use of both your eyes and ears to perform
extremely precise editing tasks.  The Audio Document win-
dow gives you a time-domain representation of sound, that
is, you see the amplitude of the sound over time.

An Audio Waveform

If you have never seen sound displayed in a visual format
before, it may not be immediately obvious how to “read” an
audio waveform. It is actually quite easy to navigate through

An audio waveform
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a recording with a waveform as your road map.  The peaks
in the waveform are areas of high amplitude (loud spots).
The valleys in the waveform are areas of low amplitude
(quiet spots). If the audio material is music with a pro-
nounced, regular beat, it is generally very easy to pick out
where the beats are simply by looking for peaks. Using this
information, and the guidelines given shortly in the “A
Selection” section, you will be able to successfully locate and
select a desired portion of the audio document and perform
the edits that you wish. The cursor marks the current loca-
tion, and also serves as an insertion point.

Vertical Scaling

Peak Express allows you to control the vertical magnifica-
tion of audio waveforms. This feature is useful if you are
editing and viewing a document with very quiet audio
material.

To increase the vertical scaling magnification:

•  Hold the Control key down and press the Up Arrow 
key.

To decrease the vertical scaling magnification:

•  Hold the Control key down and press the Down Arrow 
key.

Audio Waveform Overview

Peak Express provides an Overview display of the entire
audio waveform along the top of the screen under the menu
bar.  This provides you with a convenient visual reference of
the overall document when you are editing only a portion in
the audio document window.  The highlighted area in the
Overview display shows the area of the audio waveform cur-
rently visible in the audio document window. If desired, you
can hide the Overview display to allow the audio document
window to occupy more of the computer screen.

To show the Audio Waveform Overview:

• The Overview display appears along the top of the 
audio document window under the title bar. Check 
Show Overview in the Preference menu or  Toolbar.  A 
check next to this item indicates it is enabled.

To hide the Audio Waveform Overview:

•  To hide the Audio Waveform Overview, uncheck Show 
Overview in the Preference menu or Toolbar.

A waveform with selected audio

A Selection

A selection is just what it sounds like: a portion of audio that
you have selected by clicking and dragging with the mouse.
You must select audio in order to perform an editing action
on it. To make good selections for editing, the best rule of
thumb is to begin a selection just before a peak in the wave-
form and end it just after a peak in the waveform.  In other
words, try to make selections start and end in areas of low
amplitude (“valleys” in the waveform).  It is also important,
when possible, to begin and end a selection at a point where
the waveform meets the zero crossing line (the center line
through the waveform). This helps you avoid creating pops
and clicks if you later cut or paste the audio because the
point at which the waveform meets the zero crossing is a
point of no amplitude in the sound wave.   Pops and clicks
generally only occur if you make a careless selection and
begin or end on a portion of the sound wave where the
amplitude is high (where the waveform is high above the
center point).   
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To make sure a selection is at a zero crossing:

•  Make a selection, and then choose Snap Selection to 
Zeros from the Action menu

The Zoom In function helps you make very precise selec-
tions by letting you zoom in to a higher magnification and
select exactly the portion of the waveform you desire.  Also,
once you have made a selection, you can adjust the begin-
ning or the end of the current selection by holding down the
Shift key and clicking with the mouse.  Your selection will be
shortened or lengthened accordingly.

Channel Independent Processing

To select only the Left channel, move the cursor over it. The
cursor will show a small “L” at the insertion point. To select
only the Right channel, move the cursor over it. The cursor
will show a small “R” at the insertion point. You can process
one channel of an audio document using Peak Express’
native DSP or third-party plug-ins.

A Loop

A loop refers to a section of audio that is bounded on either
side by loop markers. In the illustration below, the area that

A waveform with loop markers

falls between the loop markers “beg loop” and “end loop”
is looped.

Loops are used to sustain or repeat a section of audio.  They
can be used for material that you intend to transfer to a sam-
pler, or simply for playback within Peak Express itself.  Peak
Express allows you to create one loop per audio file.

Audio Info Area

In the lower left corner of each Peak Express Audio
Document is the Audio Info Area.  The Info Area shows the
maximum amplitude, sample rate, bit resolution, file format,
and file size of the audio file.

Audio Info Area

Clicking on the Max dB section of the Audio Info Area will
open the Change Gain dialog, so that you can change the
gain for the entire audio file, or the current selection. For
more information on the Change Gain DSP function, please
refer to Chapter 6, DSP.  Clicking on any other portion of the
Audio Info Area will open the Audio Info dialog.

Audio Info dialog

Selecting Audio Info from the Preference menu (a-I), will
open the Audio Info dialog. The Audio Info dialog allows you
to change the sample rate, duration, root key (for use in a
sample playback instrument), and high and low key range.
Note that by changing the sample rate, the pitch and dura-
tion of the audio will be affected. (To change the sample rate
of an audio document without changing the pitch, use the
Sample Rate Conversion command from the DSP menu, or
click on the appropriate Toolbar icon.)

Peak Express allows you to select and process the
left and right channels of a stereo file independ-
ently, but you cannot edit (i.e., Cut, Paste,
Delete, etc.) the left and right channels of a
stereo file independently. 
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Audio Info dialog

Selecting Audio

In order to perform any type of editing action on an audio
document, first you must select the portion of the docu-
ment that you wish to modify.  Peak Express has several
techniques for making and modifying selections.

To make a selection with the mouse:

• Click the cursor at the desired location in the audio 
document and drag to select the desired range.

To extend or shorten a selection:

1. Make a selection with the mouse as explained above.

2. Hold down the Shift key and click on the end of the 
selection that you wish to modify.

3. Drag the mouse to extend or shorten the selection. 
When you are satisfied with the length of the selec-
tion, release the mouse.

To select audio between two loop markers:

•  Hold down the Command key (a) and click anywhere 
in between two markers.  Peak Express selects the  audio 
between the loop markers.

To select audio between loop markers with the Tab key:

1.  Create a loop in an audio document.

2. Press the Tab key on your computer keyboard.  Peak 
Express selects the portion of the waveform that lies 
between the beginning of the document and the first 
loop marker.

3. Press the Tab key again to select the portion of audio 
between the two loop markers. (If you hold down the 
Shift key while tabbing the selection through the 
audio file, you can add each successive area to the 
selection.)

4. Pressing the Tab key again selects the space between 
the second loop marker and the end of the audio doc-
ument.

To select all audio in a document:

•  Choose Select All from the Edit menu or press a-A on 
your Macintosh keyboard.

Auditioning Audio

It is often useful to audition a selection along with just a bit
of audio preceding or following it — without actually includ-
ing this material in the selection itself.  Peak Express’
Auditioning command allows you to do this by specifying a
desired amount of pre-roll or post-roll when you play the
selection.
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To audition audio with pre-roll or post-roll:

1.  Choose Auditioning from the Preference menu.  The 
Auditioning dialog appears.

The Auditioning dialog

2.  Enter the desired amount of pre-roll and post-roll and 
click OK.

3.  Click the cursor in the audio document and drag to 
select the desired range.

4.  Press Control-Spacebar.  Peak Express plays the selec
tion,adding the amount of pre-roll and post-roll that 
you specified.

Scrubbing

Dynamic Scrubbing

Peak Express provides a unique audio auditioning technique
called dynamic scrubbing.  This feature is very useful for pre-
cisely pinpointing and selecting a desired location in an
audio document.  Dynamic scrubbing allows you to drag the
mouse forward or backward over a waveform while Peak
Express plays a short loop (between 10 and 600 millisec-
onds) at the scrub location. When you have found the loca-
tion you are looking for, you can commence editing. Peak
Express allows you to choose the length of this playback
loop with the Dynamic Scrub Time command in the
Preference menu.  Peak Express provides two types of
dynamic scrubbing:

dynamic shuttle scrubbing and dynamic jog scrubbing.
Both are described below.

To select a loop duration for dynamic scrubbing:

• Choose Dynamic Scrub Time from the Preference 
menu, and choose a duration from the hierarchical 
submenu.  Typically, a value of between 40 to 80 mil-
liseconds works well.

To use dynamic “Shuttle-type” scrubbing:

1. Hold down the Control key and click and drag the 
mouse across an area of the audio document in the 
audio document window.  As you drag the mouse, 
Peak Express plays a short loop of the audio at the 
insertion point. You can control the tempo and direc-
tion (forward or backward) of playback by dragging 
the mouse slower or faster, forwards, or backwards.

2. Release the mouse button to stop scrubbing.  The 
insertion point will be exactly where you left off scrub-
bing.

Setting the Dynamic Scrub feature’s loop time
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3.  To make a selection starting at the current scrub point, 
stop scrubbing, hold down the Shift key, and click the 
mouse to extend the selection from the insertion
point to the desired location.

Jog Scrubbing

Peak Express provides a variation of the dynamic scrubbing
feature which is similar to a technique known in recording
studios as jog scrubbing.  With this technique, Peak Express
actually engages playback and moves through the file at its
normal pace, but allows you to control the playback point by
dragging the mouse.

You can control the direction (forward or backward) of
playback by dragging the mouse forwards or backwards.
This scrubbing mode affords a greater degree of control
when you are “zoomed out” in the audio document win-
dow.

To use dynamic “jog” scrubbing:

1. Hold down the Control key and Option key and drag 
the mouse across an area of the audio document in 
the audio document window.  As you drag the mouse, 
Peak Express engages playback while it loops a short 
portion of the audio at the insertion point.  Dragging 
the cursor farther away from the current insertion 
point increases the velocity of scrubbing.

2. Release the mouse button to stop scrubbing.  The 
insertion point will be exactly where you left off scrub-
bing.

3.  To make a selection starting at the current scrub point, 
stop scrubbing, hold down the Shift key,and click the 
mouse to extend the selection from the insertion point 
to the desired location.  Since jog scrubbing mode is 
engaged by pressing the Option key in combination 
with the Control key, it is possible to toggle back and 
forth between jog and shuttle modes simply by press-

ing or releasing the Option key.

Tape-Style Scrubbing

In addition to dynamic scrubbing feature, Peak Express pro-
vides tape-style scrubbing. To enable tape-style scrubbing,
set the Dynamic Scrub Time under the Preference menu to
Tape-Style.

To start tape-style scrubbing:

• Hold down the Control key on your keyboard, and 
then click and drag the mouse at the location where 
you wish to begin scrubbing.

To deactivate tape-style scrubbing:

•  Release the mouse and Control key.

To control tape speed in tape-style scrubbing:

1.  As you drag the mouse towards the right, scrubbing 
speed will increase.

2.  As you drag the mouse toward the left, scrubbing will 
slow down.

3. If you drag the mouse to the left of the point where 
you started scrubbing, the scrub direction will change 
from forward playback to backwards playback.

The playback bar will show the scrubbing speed at the top
of the playbar.  Playback speed can vary from minus four
times (–4.0x) to four times (+4.0x) original playback speed.

To use Tape-Style scrubbing, Peak Express must
be configured to use Mac OS X Audio HAL – To
configure this, click on the Audio menu>Sound
Out, and choose “Mac OS X Audio HAL” from the
submenu.
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Using Undo and Redo

Peak Express maintains an internal list of the last five edits
that you perform during the course of an editing session.
These changes are not permanently applied to the file until
you save it.  This gives Peak Express multiple undo and redo
capability.  Through the use of the Macintosh’s standard
Undo and Redo commands, you can undo and redo your
actions sequentially.   This powerful capability allows you to
maintain complete creative freedom of choice—right up
until the last moment before you save your project to disk.
The only limitation in using Redo is that if you insert a new
action when a redo action is available, you will no longer be
able to redo.  Remember, as soon as you perform an editing
action other than Undo in Peak Express, Redo is no longer
available.

To undo an action:

1.  Perform an edit (such as cutting audio or moving a
marker).

2.  Choose Undo from the Edit menu (a-Z) or Toolbar. 
The action is undone.

3. You can continue undoing actions until you return to 
the original state of the audio document (the state at 
which it was last saved). When there are no actions left 
to undo, the Undo menu item will appear grayed out.

To redo an action:

1. If you wish to redo the action that was undone, 
choose Redo from the Edit menu (a-Y ) or Toolbar. 
The action is redone.

2.  You can continue redoing actions until there are none 
left to redo. When there are no actions left to redo, 
the Redo menu item will appear grayed out.

Essential Editing Functions

Peak Express supports all of the Macintosh’s essential edit-
ing functions such as cut, copy, and paste and provides sev-
eral more specifically designed for audio editing.

This section explains how to use each of these functions.

Because Peak Express allows you to have multiple audio
documents open at the same time, it is possible to conve-
niently cut, copy, paste, and insert audio between docu-
ments.  This makes combining material from several audio
documents very fast and easy.

Scratch Disks

Because audio data can be very large, Peak Express utilizes a
portion of your hard disk’s free space to hold audio data that
has been cut or copied, as well as for temporary or scratch
files for undo purposes.  If you have more than one hard
drive attached to your Macintosh, the Scratch Disks com-
mand in the Preference menu allows you to choose the hard
drives (or “scratch disks”) that you wish to use for these
temporary files.  Peak Express allows you to select which
disk you want to have as your default, or “Primary” disk for
this purpose--ideally you would select the disk that has the
most free space.  If you are connected to a file server, you
can utilize available storage on the server by clicking the
Allow Servers checkbox (that is if you have a very fast server 

The Scratch Disks dialog

To return a file to its original, un-edited state,
simply close the file without saving
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connection).  Any available servers will then appear in the
Scratch Disks pop-up menu.  This is recommended only if
you have access to a high-speed ethernet, Media Net, or
other fast server.

Clearing the Clipboard to Reclaim Disk

Space

If you no longer need the clipboard contents, you can free
up the disk space occupied by the clipboard by choosing the
Clear Clipboard command from the Edit menu.

Cutting Audio

The Cut command (a -X) allows you to cut a selected range
out of a audio document.  Audio that occurs after the cut
slides over to fill in the gap.  By cutting and pasting “pieces”
of audio, you can freely rearrange material in an audio doc-
ument.  This can be a powerful tool for creating audio remix-
es for music-oriented applications, as well as an indispensa-
ble tool for general sound design tasks.  When you cut a
selection, the Macintosh holds the cut audio data in its inter-
nal memory (the Clipboard) in case you wish to paste it else-
where.  Because all real time editing you do with Peak
Express is nondestructive, the audio isn’t actually removed
from the original audio document until you finally save the
file to disk with the Save command.  At that time, all edits are
saved and any changes that you have made are permanently
saved to the audio document.

To cut a selection:

1.  Click the cursor at the desired location in the audio 
document and drag to select the desired range.

2.  Choose Cut from the Edit menu ( a-X) or Toolbar.

3.  The selected range is removed from the audio docu
ment(s) and held on the Clipboard.  Audio occurring 
after the cut slides over to fill in the gap.

Deleting Audio

If you wish to remove a section of audio from an audio doc-
ument without using the Cut command, you can use the
Delete key, or the Delete button on the Toolbar. As with the
Cut command and other editing functions, the audio isn’t
actually removed from the original audio document until
you save the file to disk.

To delete a selection:

1. Click the cursor at the desired location in the audio 
document and drag to select the desired range.

2.  Press the Delete key, or click the Delete button on the 
Toolbar.

3. The selection is removed from the audio document. 
Audio occurring after the deleted section slides over 
to fill in the gap.

Copying Audio

The Copy command ( a-C) copies the current selection to
the Macintosh’s Clipboard (or internal memory buffer) so
that you can paste it, insert it, or use it with optional
“Clipboard-based” processing such as the DSP menu’s Mix
command.  As with the Cut command, copying and pasting
“pieces” of audio, allows you to freely rearrange material in
a document.

This can be a powerful tool for creating audio remixes for
music-oriented applications, and an indispensable tool for
sound design.

To copy a selection:

1. Click the cursor at the desired location in the audio 
document and drag to select the desired range.

2.  Choose Copy from the Edit menu (a -C) or Toolbar.
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3.  The selection is copied to the Clipboard.  At this point, 
you can use either the Paste or Insert commands to 
place the copied audio into an audio document.  Each 
of these commands are explained below.

Pasting Audio

The Paste command (a-V ) allows you to paste the contents
of the Clipboard into a location that you choose by placing
an insertion point.  Pasting audio deletes any selected audio
and inserts the clipboard audio at the insertion point.  By
cutting and pasting pieces of audio, you can freely re-
arrange material in an audio document. In musical applica-
tions, this gives you the freedom to entirely “rewrite” com-
positions by changing the order of things, repeating desired
sections, and so on.  In sound design applications, this gives
you the power to “compose” with sound by creating audio
collages.

To paste audio into an audio document:

1. Click the cursor at the point where you wish to paste 
the audio data in an audio document or make a selec-
tion of audio you want to delete and replace with the 
contents of the clipboard.

2. Choose Paste from the Edit menu (a -V ) or Toolbar. 
The Clipboard contents are pasted into the audio docu-
ment(s), beginning immediately after the insertion 
point.  Any selected audio at the location of the paste is 
overwritten when the pasted data is inserted into the 
audio document.

Replacing Audio

The Replace command allows you to paste audio data over
existing audio – to paste audio into an audio document
without pushing all data to the right of the insertion point
farther to the right (later in time) to accommodate the newly
pasted audio.  The Replace command is useful for “laying 

over”  a portion of audio while maintaining the timing of the
original document.

To replace audio into an audio document:

1.  Click the cursor at the point where you wish to replace 
the audio data in an audio document.

2. Choose Replace from the Edit menu or Toolbar.  All 
data to the right of the replaced audio maintains their 
time position.

Inserting Audio

The Insert command ( a-D) allows you to paste audio data
into an audio document without overwriting any existing
data at the insertion point.  When you paste data with the
Insert command, all data to the right of the insertion point
or selection start is pushed farther to the right (later in time)
to accommodate the newly pasted audio.  The Insert com-
mand is one of Peak Express’ most useful tools for restruc-
turing the contents of an audio document. It is particularly
good for “composing on the fly” since it allows you to cut
and insert pieces of audio—musical phrases, riffs, or simply
textural sounds—to create a composition or soundscape.

To insert audio into an audio document:

1.  Click the cursor at the point where you wish to insert 
the audio data in an audio document.

2.  Choose Insert from the Edit menu (a-D) or Toolbar. 
All data to the right of the insertion point is pushed 
farther to the right (later in time) to accommodate the 
newly pasted range.

Cropping a Selection

The Crop command (a -`) allows you to make a selection
in an audio document and quickly and easily remove all
other audio from the audio document except the selection.
The Crop command is a particularly useful tool for editing 



Peak Express User’s Guide 49

material to be used as samples or sound effects, since it
allows you to isolate and save just the desired portion of a
recording.

To crop a selection:

1. Click the cursor at the desired location in the audio 
document and drag to select the desired range.

2. Choose Crop from the Edit menu (a -`) or Toolbar.  
All audio but the selection is removed from the audio 
document.

New Document from Selection

The New Document from Selection command will automat-
ically create a new Audio Document containing the selected
audio from the source document.

To create a new document from a selection:

1.  Make a selection in any open audio document that you 
want to have as its own document.

2. Choose Document from Selection from the New sub-
menu under the File menu (Control--N).

3.  A new audio document will be created with the select
ed audio.

Silencing a Selection

The Silence command (a -E) replaces the selected audio in
the audio document’s selection with silence.  This feature is
very useful for silencing nonessential portions of a recording
that contain an unusual amount of noise.  This can be used
very successfully with spoken material such as dialog or nar-
ration to remove noise between words or during pauses in
speech.  It can also be used to remove pops or clicks that
occur in such material.

To silence a selection:

1. Click the cursor at the desired location in the audio 
document and drag to select the desired range.

2.  Choose Silence from the Edit menu (a -E) or Toolbar.  
The selected audio is replaced with silence.

Creating Fade Ins and Fade Outs

Peak Express allows you to create fade ins or fade outs at any
point in an audio document.  Fade ins/outs can be very use-
ful for smoothly fading in or out of an audio document, or
for fading out of one type of audio material into another.
Very short fade ins can also be useful for smoothing or
removing clicks and pops in a recording.  

To create a Fade In:

1. Click the cursor at the desired location in the audio 
document and drag to select the range you desire.  
The Fade In will be applied to the audio within this 
selection.

2. Choose Fade In from the DSP menu.  Peak Express 
applies the Fade In to the selection you have made in 
the audio document.

3.  To hear the completed Fade In, press Option-Spacebar. 
You will hear the selected audio complete with your 
Fade In.

To create a Fade Out:

1. Click the cursor at the desired location in the audio 
document and drag to select the range you desire.  
The Fade Out will be applied to the selected audio.

2. Choose Fade Out from the DSP menu. Peak Express 
applies the Fade Out to the selection you have made 
in the audio document.
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3.  To hear the Fade Out, press Option-Spacebar.  You will 
hear the selected audio complete with your Fade Out.

Creating Loops

If you’re editing music or other rhythmically-based material,
it is generally a good idea to test a selection to make sure it
contains an even number of beats before you cut, copy, or
paste it.  A good way to do this is to loop the selection and
listen to the loop as it plays.  

To play a loop in Peak Express, select Use Loop in Playback
command (a-L) from the Preference menu or click the
loop button on the Cursor Palette, begin playback, and
when Peak Express reaches the loop, it will continue to
repeat until you stop playback.  If Use Loop in Playback is
not enabled, Peak Express will simply play right through the
loop to the end of the audio document or selection.

To create a loop from a selection:

1. Click the cursor at the desired location in the audio 
document and drag to select the range you want.

2. Choose Loop This Selection from the Action menu
(a- Shift-”-”) or Toolbar.  Your selection is now looped. 
Loop markers appear at the beginning and end of the 
loop.

3.  To listen to the loop, choose the Use Loop in Playback 
command (a-L) from the Preference menu (a check 
next to this menu item indicates it is enabled), or click 
the Loop button on the Cursor Palette, and start play-
back by pressing the Spacebar on your keyboard.

4. You can interactively fine tune a loop by dragging the 
loop start or end markers while loop playback is 
engaged.  As you drag a loop marker to a new location, 
Peak Express will adjust the playback loop to reflect the 
changes you make.  

To move a loop marker:

• Using the mouse cursor, click the triangular “flag” at 
the bottom of one of the loop markers, and drag to the 
desired location.

To listen to the loop only:

1. Choose Select Loop (a-“-”) from the Edit menu to 
select the loop.

2. Make sure loop playback is enabled using the Use 
Loop in Playback command from the Preference menu 
(a check next to this menu item indicates it is 
enabled), or by pressing the Loop button on the 
Cursor Palette.

3.  Press the Spacebar to begin playing back the loop.

Conclusion

You have now learned how to manipulate audio with Peak
Express’ various editing tools, including how to work with
Loops.  In the next chapter you will learn more about  Peak
Express’ DSP (Digital Signal Processing) Tools.
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Chapter 6:
DSP
(Digital Signal Processing)

Introduction

Peak Express allows you to transform your audio with a vari-
ety of powerful Digital Signal Processing (DSP) tools.  You
can apply these tools at any time by first making a selection
in an audio document and then choosing the desired menu

command from the DSP menu.

Processing Audio with Peak Express' DSP Tools

The following general procedure describes how to process a
selection in an audio document, or the entire document,
with a particular DSP function.  The specific capabilities and
parameters of the DSP function will vary.

To process audio with a DSP function:

1.  Select the portion of the audio that you wish to process 
with the DSP function. If no selection is made, the entire 
document will be processed.

2.  Select the type of process you wish to use from the DSP 
menu.

3.  A dialog appears allowing you to set the parameters for 
the DSP function.

4.  Set the parameters for the DSP function as desired and 
click OK. Peak Express processes the selection with the 
DSP function or plug-in.

Peak Express’ Audio Processing Tools

Peak Express’ DSP capabilities provide composers and pro-
fessional sound designers with many interesting audio
effects and processing tools. Peak Express’ DSP functions
include Change Gain, Convert Sample Rate, Invert, Fade In,
Fade Out, Gain Envelope, Mix, Normalize, and Reverse.  The
following sections explain how to use each of these func-
tions.

Change Gain

The Change Gain function changes the gain (i.e., amplitude)
of a selection.  You can specify the amount of gain change
either in decibels (dB) or as a percentage. If you wish to
double the volume of a sound, you must apply approxi-
mately 6 dB of gain change, or add 200%. Enable the
Clipguard checkbox in the Change Gain dialog to protect
against the possibility of clipping. Clipguard will search
through the audio document or selection for the maximum
peak in amplitude, and then limit the Change Gain slider’s
range based on the maximum peak it finds in the audio doc-
ument or selection.

The Change Gain dialog

To change the gain of a selection:

1.  Select the portion of the audio that you wish to 
process.

that if no selection is made, Peak Express will
apply processing to the entire audio document.
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2. Choose the Change Gain command from the DSP 
menu or from the Toolbar. The Change Gain dialog 
appears.

3. Enter the number of decibels or percentage by which 
you wish to change the amplitude of the selection by.

4. If you wish to protect against the possibility of clip-
ping, enable Clipguard by checking the Clipguard 
checkbox.

5. Click OK when you have finished. Peak Express will 
change the gain of the signal by the amount you spec -  
fied.

Convert Sample Rate

The Convert Sample Rate command allows you to change
the sample rate of a sound without changing its pitch.  This
feature is very useful for converting audio material into
lower or higher sample rates as required by other applica-
tions.  Please note that sample rate conversion is applied to
an entire document.  It cannot be applied to just a selection
within a document. 

1. Choose Convert Sample Rate from the DSP menu or 
Toolbar. The Convert Sample Rate dialog appears.

2. Type in the sample rate that you wish to convert the 
audio document to, or click the down arrow to select 
from a pop-up of commonly used sample rates.

3.  Click OK. Peak Express converts the entire audio docu
ment to the selected sample rate.

The Convert Sample Rate dialog

Invert

The Invert function allows you to invert the phase of a
selection or an entire audio document.

To invert the phase of a selection:

1.  Select the portion of the audio that you wish to invert.

2. Choose Invert from the DSP menu.  Peak Express 
inverts the phase of the selected audio.

Fade In & Fade Out

The Fade In and Fade Out commands allow you to apply
an amplitude envelope to an audio selection. 

To create a Fade In:

1. Click the cursor at the desired location in the audio 
document and drag to select the audio you want to 
fade. The Fade In will be applied to the audio within 
this selection.

2. Choose Fade In from the DSP menu. Peak Express 
applies the Fade In to the selection you have made in 
the audio document.

3. To hear the completed Fade In, press Option- 
Spacebar.  You will hear the selected audio complete 
with your Fade In.

To create a Fade Out:

1. Click the cursor at the desired location in the audio 
document and drag to select the audio you want to  
Fade.  The Fade Out will be applied to the selected 

Peak Express is limited to 44.1 & 48 kHz sampling
rate conversions.
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audio.

2.  Choose Fade Out from the DSP menu. Peak Express 
applies the Fade Out to the selection you have made 
in the audio document.

3.  To hear the Fade Out, press Option-Spacebar.  You will 
hear the selected audio complete with your Fade Out.

Gain Envelope

The Gain Envelope operation allows you to enter an ampli-
tude envelope to be applied to an audio selection.  The
selected audio’s amplitude will be boosted and/or attenuat-
ed according to the envelope you draw in the Gain Envelope
editor.  It is easy to cause samples to clip when using this fea-
ture, so use it carefully.

To apply variable gain and attenuation to an audio

selection:

1 . Select the audio material you wish to process.

2.  Choose Gain Envelope from the DSP menu.

The Gain Envelope dialog

3. Draw the gain envelope you wish to apply to the 
audio selection in the envelope editor.  Points above 
the 0% line will amplify the selected audio.  Points 
below the 0% line will attenuate the selected audio.  
Note that the waveform display in the Gain Envelope 

editor will change according the envelope you draw.

4. To process the audio selection using the gain enve-
lope, press Change.

Mix

The Mix command allows you to mix material that you have
copied to the clipboard with a target selection.  This func-
tion can be used as a kind of “sound-on-sound” capability for
mixing audio tracks together, or for blending sound ele-
ments.  To use the Mix command, you must first copy a
selection of audio. The copied material can then be mixed
into the target audio material.

To use the Mix command:

1. Select the audio you wish to mix into another audio 
document and choose Copy from the Edit menu or 
Toolbar (or press a-C).

2.  Select the audio that you wish to mix the copied mate-
rial into.

3.  Choose Mix from the DSP menu.

The Mixer dialog
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4.  In the dialog that appears, use the slider to adjust the 
amount of the copied signal that you wish to mix into 
the target audio document.

5.  Click OK. Peak Express mixes the two signals together.

6.  To hear the results, press Option-Spacebar.

Normalize

This command allows you to optimize the volume of a selec-
tion or an entire audio document so that it is at its maximum
possible amplitude without clipping.  The normalize func-
tion is very useful for boosting the volume of material that
was recorded at too low a level, or if used on multiple audio
documents, for making sure that the amplitude of each of
the documents is uniform.

Note that because normalization uniformly changes the
amplitude of a selection (i.e., the proportions between loud
and soft stay the same), it does not have the same effect as
compression/limiting (which makes the soft parts louder
and does not allow the loud part to exceed a specified ampli-
tude).

To normalize a selection:

1. Select the audio that you wish to normalize.  If you 
wish to normalize the entire audio document, choose 
Select All from the Edit menu (a-A).

The Normalize dialog

2.  Choose Normalize from the DSP menu.

3.  In the dialog that appears, use the slider to adjust the 
percentage of normalization from the maximum level.

4.  Click OK.  Peak Express normalizes the selected audio.

Reverse

The Reverse command reverses the current selection.  In a
reversed selection, the last sample becomes the first sample,
the second-to-last sample becomes the second sample, and
so-forth.  The effect is similar to playing a record or cassette
tape backwards.

To reverse a selection:

1.  Select the audio that you wish to reverse.  If you wish 
to select the entire document, choose Select All from 
the Edit menu (a-A).

2.  Choose Reverse from the DSP menu.  Peak Express 
reverses the selected audio.  To hear the results, start 
playback.

Conclusion

You have now learned how to manipulate and process
audio using Peak Express’ native DSP capabilities.  In the
next chapter, you will learn how to use third-party audio
effects plug-ins with Peak Express.



Chapter 7
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Chapter 7:
Plug-Ins

Introduction

Peak Express supports third party audio effects plug-ins in
the Audio Unit & VST formats. 

Audio Unit plug-ins are a new standard in “native”, or CPU
based realtime audio effects plug-ins from Apple.  Audio
Unit plug-ins can be shared between any applications that
support this standard.

VST (“Virtual Studio Technology”) is a standard audio plug-
in technology developed by Steinberg Media Technologies,
AG.  VST plug-ins offer an exciting array of real-time effects
by companies like BIAS, Cycling 74, Steinberg, Waves, and
others. 

Audio Unit & VST plug-ins are real-time, “host-based” audio
plug-ins that run on your computer without any additional
hardware.

Installing VST Plug-Ins

VST plug-ins are installed in one of the following directories,
depending on whether you want system-wide access, or
access only for selected user accounts.

•  Users/<YourUserAccount>/Library/Audio/VST/

•  MacintoshHD/Library/Audio/VST/

Be sure to consult the documentation that came with your
VST plug-ins for the manufacturer’s installation instructions.

Using VST Plug-Ins

To use a VST format plug-in, click on Peak Express’ Plug-Ins
menu, and select VST>Insert 1>and choose the plug-in
you wish to use from the submenu.  VST plug-ins will vary in
appearance depending on the manufacturer – some VST 

plug-in interfaces will contain controls such as knobs, 
sliders, buttons, etc.  Despite the differences in appearance,
applying a VST effect to an audio document always follows
the same procedure.

To apply a VST plug-in:

1.  Open an audio document

2. Select area of waveform to be processed (if no selec-
tion is made, the entire file will be processed).

3.  From the Plug-Ins menu>VST choose the plug-in you 
wish to use.

4.  Make desired settings in VST plug-in interface (consult 
plug-in documentation if necessary).

5.  From the Plug-Ins menu, choose “Bounce” to apply 
the effect to the document or selection.

6.  After each VST bounce, you will be prompted to either 
close the plug-in, or leave it active – if you have no 
further processing to do, close the plug-in – if you 
have additional files to process with the same effect, 
leave it active.

If you leave VST plug-ins active after bouncing,
click the “Bypass” button on the plug-in interface
(indicated with the letter “B”) to hear a true rep-
resentation of the audio document.  Since the
effect has already been applied and the plug-in is
still active, you would hear a processed file being
played in real time through the same effect plug-
in, giving the impression of double the desired
effect.
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To disable a VST plug-in:

•  From the Plug-Ins menu, choose VST>Insert 1>None

VST Plug-In Compatibility

Peak Express supports only BIAS Freq2, Freq, and SuperFreq
Equalizer plug-ins, and BIAS SoundSoap VST format effects
plug-ins.  More information about each is provided below.

BIAS Freq

BIAS Freq is a professional-caliber 4-band EQ.  Freq supports
–18 dB to +18 dB Gain Values, 0.1 to 10 Q (bandwidth)
vaues, and sweepable frequencies from 20 Hz to 20 kHz.
Freq has Peak, Notch, High-Shelf, and Low-Shelf filters avail-
able for each band.  Freq also includes individual band
bypass buttons, and 24 dB stereo input and output meters.
For more information on using BIAS Freq, please refer to the
BIAS Freq User’s Guide.  

BIAS Freq is available to Peak Express owners at no charge,
just by registering Peak Express via the BIAS website.  Upon
successful registration, you will be emailed a URL from
which to download Freq.  (SuperFreq is available as an
upgrade from BIAS).

BIAS Freq

BIAS SoundSoap

SoundSoap is a professional-quality, yet extremely easy to
use broadband noise reduction plug-in (also available as a
stand-alone application).  With just a few simple controls to
learn, SoundSoap is designed to reduce/eliminate back-
ground noise such as hum, hiss, buzz, air conditioner/fan
noise, camera motor noise, and other kinds of annoying
background noise that detracts from the quality of digital
media files.

A demonstration copy of SoundSoap is installed with Peak
Express, and will allow up to 14 days of fully functional
usage.  For more information about SoundSoap, please visit:

http://www.bias-inc.com/soundsoap

BIAS SoundSoap

VST Plug-In Delays

To compensate for VST plug-in delays when bouncing VST
effects on a selection, hold down the Option key when
choosing Bounce VST Effects and enter the delay compen-
sation you want in samples.

To determine delay compensation:

1. Bounce VST effects.

2. Measure the silence inserted by the bounce by selecting
the silence and viewing the duration of the selection in sam-
ples.
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To apply an Audio Unit plug-in:

1.  Open an audio document

2. Select area of waveform to be processed (if no selec-
tion is made, the entire file will be processed).

3.  From the Plug-Ins menu>Audio Unit choose the plug-
in you wish to use.

4.  Make desired settings in Audio Unit plug-in interface 
(consult plug-in documentation if necessary).

5.  From the Plug-Ins menu, choose “Bounce” to apply 
the effect to the document or selection.

6.   After each Audio Unit bounce, you will be prompted to 
either close the plug-in, or leave it active – if you have
no further processing to do, close the plug-in – if 
you have additional files to process with the same
effect, leave it active.

To disable an Audio Unit plug-in:

•  Click the red close button in the upper left corner of 
the plug-in’s interface, or un-check the plug-in under 
the Audio Units plug-in submenu.

Apple AUReverbMatrix is an example of an Audio Unit effect plug-in

3.  Undo the bounce.

4.  Hold down the Option key while choosing Bounce 
VST Effects.

5.  Enter the VST delay compensation amount from
step 2.

6.  Click OK or press Return.

The Bounce Effects dialog

Using Audio Unit Plug-Ins

To use an Audio Unit format plug-in, click on Peak Express’
Plug-Ins menu, and select Audio Unit, and choose the plug-
in you wish to use from the submenu.  Audio Unit plug-ins
will vary in appearance depending on the manufacturer –
some Audio Unit plug-in interfaces will contain controls
such as knobs, sliders, buttons, etc.  Despite the differences
in appearance, applying a Audio Unit effect to an audio doc-
ument always follows the same procedure.
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Apple’s ReverbMatrix is an example of an Audio Unit plug-in.
Audio Unit plug-ins operate in real-time, and can be used in
any applications that support Audio Units.  Because of this
functionality, you will notice that the same Audio Unit effects
available within Final Cut Pro 4 are also available within Peak
Express.

Conclusion

You have now learned how to manipulate and process audio
using VST and Audio Unit plug-ins.  In the next chapter, you
will find a summary of Peak Express’ various menu items.



Chapter 8
Peak Express Menus
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Chapter 8:
Peak Express Menus

This chapter explains each of the commands found in Peak
Express’ menus.  For step-by-step instructions on imple-
menting these commands, refer to the table of contents, and
go to the appropriate chapter where use of the command is
covered.

File Menu

This menu contains all of the standard Macintosh com-
mands for opening, closing, and saving files, as well as sev-
eral additional commands specific to the Peak Express appli-
cation.

New

This command allows you to create a new Peak Express
audio document.  When you choose this command, a sub-
menu menu appears which allows you to choose either a
mono or stereo format for the new audio document.

Mono Document

Choosing Mono Document (a-N) creates a mono (one
channel) audio document.

Stereo Document

Choosing Stereo Document (Shift-a-N) creates a stereo
(two channel) audio document.

Document From Selection

Choosing Document From Selection (Option-N) creates a
new audio document from any selected audio in an open
audio document.

Open

The Open command (a-O) allows you to locate and open 

audio documents in a variety of formats including AIFF,
WAVE, and QuickTime.

Peak Express allows you to have two audio documents
open simultaneously.

The Open dialog

Close

The Close command (a-W ) closes the currently active Peak
Express audio document. If you haven’t saved changes, Peak
Express will prompt you to do so before it closes the docu-
ment. If you have many documents open and don’t wish to
save any of the changes you’ve made, option-click on the
prompt dialog's Don't Save button.

Close All

The Close All command (Option-a-W ) closes all open Peak
Express audio documents. If you haven’t saved changes,
Peak Express will prompt you to do so before it closes the
documents. If you don’t wish to save any of the changes
you’ve made, option-click on the prompt dialog's Don't Save
button.

Save

The Save command (a-S) saves the current audio docu-
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ment.  Peak Express can save audio documents in a variety
of file formats including:

•  AIFF: This is Apple’s Audio Interchange File Format.  It 
is also Peak Express’ default file format and is support-
ed by many Macintosh software applications.

•  WAVE: This is Microsoft’s Windows Audio File Format. It 
is supported by many Window’s software applications 
and some Macintosh applications. The WAVE format is 
best if you plan to use an audio document in an appli-
cation that supports or requires WAVE format files.

• QuickTime: This is Apple’s audio file format for 
QuickTime-based multimedia. It is supported by all 
Macintosh software applications that support 

QuickTime. The QuickTime format is best if you plan to 
use an audio document in multimedia applications that 
support QuickTime, such as Adobe Premiere™ or  
Macromedia Director™.

Different formats allow different information to be stored
with the file. If you open a file created in a format other than
Peak Express’ default AIFF format, Peak Express will pre-
serve any format-specific information unless you save the
file into a different file format.  Saving a file in a different for-
mat than its original format, however, may cause some infor-
mation stored in the file to be discarded.

Save As

The Save As (Shift-a-S) command allows you to save a
copy of the current audio document under a different
name, in a different location on your hard drive, or in a dif

ferent audio file format.  The saved copy will become the
active open audio document.  You can save the document
with a variety of audio compression schemes.  For detailed
instructions on using this feature, see Chapter 3: Peak
Express Basics.

The Save As dialog

Peak DV and the full edition of Peak allow saving in many
more file formats, including Sound Designer II, Raw, System
7 Sound, Sonic AIFF, .paf, JAM Image, .au, and MP3.

In addition to saving in these additional formats, these more
advanced editions of Peak also allow various types of file
compression, such as Q-Design Music, Alaw 2:1, MACE 3:1,
MACE 6:1, 32-bit floating point, IMA 4:1, 24-bit integer, 32-bit
integer, 16-bit Little Endian, and 16-bit Big Endian.

The full edition of Peak also supports higher bit depths and
sampling rates – up to 32-bit/10mHz, when using supported
audio hardware.  Higher bit depth files can be converted to
lower bit depth files, using the advanced POW-r dithering
algorithm that is only available in the full edition of Peak.

Peak Express will only allow you to save edits to
an existing QuickTime file – you cannot save an
AIFF or WAVE file as QuickTime.
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Save A Copy As

The Save A Copy As command (Option-a-S) allows you to
save a copy of the currently active open audio document
under a different name without replacing the active open
audio document.

Import CD Track

The Import CD Track command allows you to import tracks
from an audio CD. CD tracks imported to Peak Express will
be saved as AIFF files. For more detail on importing CD
audio with Peak Express, see Chapter 4: Playing back Audio.

Import CD Audio dialog

Export Dual Mono

The Export Dual Mono command allows you to save a stereo
audio document as separate mono digital audio documents.
This feature is convenient if you intend to use the audio doc-
ument in a multitrack audio application, such as BIAS Deck
or Pro Tools, which does not directly support stereo audio
files.  When you choose this command Peak Express will
prompt you to name both the left and right sides with a Save
dialog.

Recently Opened Documents

Peak Express automatically remembers the last several audio
documents or playlists that you have opened and keeps a list 

of these at the bottom of the File dialog.  This allows you to
easily select a document’s name and reopen it without hav-
ing to search for it on your hard drive. Peak Express can find
and open a document even if you have changed its location
on your hard drive, too.  And if you change the name of the
file, the next time you open Peak Express, Peak Express will
automatically update the name in its internal list.

Quit

The Quit command (a-Q) can be found under under the
Peak Express menu.  Choosing Quit closes the Peak Express
application. If you haven’t saved changes to a currently open
audio document, Peak Express will prompt you to do so
before quitting.

Edit Menu

This menu contains all of the standard Macintosh com-
mands for cutting, copying, and pasting, as well as several
other commands specific to Peak Express.

The Edit menu

Undo

The Undo command (a-Z) undoes the last action that you
performed.  Since Peak Express features unlimited undo
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and redo capability, repeatedly choosing this command will
undo each action that you have performed on your audio
document.  If you wish, you can continue undoing actions
until you return to the original state of the audio document.
When there are no actions left to undo, the Undo command
will be unavailable and appear grayed out.

Redo

The Redo command (a-Y ) “undoes” the undo command. If
you wish, you can continue redoing actions until there are
no items left to redo.  In this case, the Redo command will
be unavailable and appear grayed out.  The only limitation in
using the Redo command is that if you insert a new action
when a redo action is available, you will no longer be able to
redo.  In other words, as soon as you perform an editing
action other than Undo, Redo is no longer available.

Cut

The Cut command (a-X) cuts selected data from an audio
document and a copy of it on Peak Express’ Clipboard. Once
you have cut a portion of an audio document, you can paste
it or insert it at another location in the same document or a
different document.

Copy

The Copy command (a-C) copies selected audio in Peak
Express’ Clipboard. Once you have copied a portion of an
audio document, you can paste it or insert it at another loca-
tion in the same document or a different document.

Paste

The Paste command (a-V ) allows you to paste the contents
of the Clipboard into a location that you choose by placing
an insertion point.  Pasting audio deletes any selected audio
and inserts the clipboard audio at the insertion point.

Replace

The Replace command allows you to paste audio over exist-
ing audio—to paste audio into an audio document without
pushing all data to the right of the insertion point farther to
the right (later in time) to accommodate the newly pasted
audio.

Insert

The Insert command (a-D) allows you to paste audio into
an audio document without overwriting any existing data at
the insertion point. When you paste data with the Insert
command, all audio to the right of the insertion point or
selection start is pushed farther to the right (later in time) to
accommodate the newly pasted audio.

Silence

The Silence command (a-E) replaces the selected audio in
the audio document’s selection with silence.

Delete

The Delete command (the Delete key) allows you to cut an
audio selection without transferring it to the Clipboard.

Delete Except Audio

The Delete Except Audio command (Option-Delete) allows
you to easily remove all loop markers in the current audio
document selection without removing the audio.

Crop

The Crop command (a-`) allows you to remove all other
audio from the audio document except the selection.

Clear Clipboard

Peak Express utilizes a portion of your hard disk’s free 

Only 5 levels of undo/redo are available in Peak
Express.
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space to hold audio that has been cut or copied. The Clear
Clipboard command allows you to free up disk space occu-
pied by the contents of the clipboard if you no longer need
the audio contained there.

Select All

The Select All command (a-A) selects all audio in the audio
document.

Insertion Point at Selection Start/End

The Insertion Point at Selection Start command (Up Arrow)
places the insertion point at the beginning of a selection.
The Insertion Point at Selection End command (Down
Arrow) places the insertion point at the end of a selection.

Set Selection

The Set Selection command allows you to precisely edit the
length, start and end times of an audio selection by entering
numerical values ion the Set Selection dialog. Use the Units
pop-up menu at the top of the dialog to select the time units
you want, and use the radio buttons to select whether you
want to affect the Start or End of the selection.

Select Loop

The Select Loop command (a-”-”) will automatically select
the audio within the loop start and loop end markers, if you
have defined a loop in a document.

Previous Selection/Next Selection

If you have made a selection in an audio document, then
made another selection, you can use Previous Selection (a-
Left Arrow) to jump back to the previous selection. You can
then use Next Selection (a-Right Arrow) to jump ahead
again. This works for multiple selections.

Action Menu

This menu provides several commands for zooming in and
out of the audio document window, creating loops, and
navigating to specific locations in an audio document.

The Action menu

Zoom Out

The Zoom Out command (a-[) zooms the waveform view
out allowing you to see more of the entire waveform, but in
less detail. The Zoom Out command is useful for obtaining
a better “big picture” view of audio material.  To zoom pro-
gressively out from a waveform, select this command repeat-
edly or press a-[ repeatedly on your computer keyboard.

Zoom In

The Zoom In command (a-]) zooms the waveform view in
so that you can view audio data in greater detail.  The Zoom
In command is essential when you wish to select and edit
audio with great precision.  To view a waveform in progres-
sively greater detail, select this command repeatedly or
press a-] repeatedly on your computer keyboard.  Holding



Peak Express User’s Guide 67

down the Option key while you make a selection will zoom
the waveform view in so that your selection fills the audio
document window after you release the mouse button.

Increase Vertical Zoom

The Increase Vertical Zoom command (Control-Up Arrow)
makes the waveform “taller,” or increases the vertical zoom.
The Increase Vertical Zoom command is useful for obtaining
a better “big picture” view of quieter audio material.

Decrease Vertical Zoom

The Decrease Vertical Zoom command (Control-Down
Arrow) makes the waveform “shorter,” or decreases the
vertical zoom.

Zoom Out All the Way

The Zoom Out all the way command (Shift-a-[) zooms
the audio document window to show an overview of
the entire audio document.

Zoom at Sample Level

The Zoom at Sample Level command (Shift-Left Arrow)
zooms the audio document window to the single-cycle level,
allowing you to view the waveform a single sample at a time.
This is useful for drawing on the sample with a pencil tool,
or fine-tuning loops and markers.

Zoom at Sample Level (End)

The Zoom at Sample Level (End) command (Shift-Right
Arrow) zooms the audio document window to the single-
cycle level and places the insertion point at the end of the
audio selection.

Loop This Selection

The Loop This Selection command (Shift-a-”-”) automati-
cally creates a loop from the current selection by placing 

loop markers on either side of the selection.  Since Peak
Express supports a single loop per audio document, choos-
ing this command in a document with a loop already defined
will cause the loop markers to move to the current selection.

Go To

The Go To command (a-G) allows you to quickly and pre-
cisely navigate to a the start or end of a selection, the start
or end of a loop, a specific marker, or a specific time loca-
tion in an audio document.  This command is essential for
speedily locating any of these important locations in an
audio document. Choosing the Go To Time command
allows you to enter the exact time location that you wish to
navigate to.  

The Go To Time dialog

Audio Menu

The Audio menu contains commands for playing back audio,
as well as configuring Peak Express’ Audio Settings, your
audio hardware.

The Audio menu
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Stop/Rewind

The Stop/Rewind command (Return) stops playback and
places the insertion point at the beginning of the audio doc-
ument.

Play/Pause

The Play/Pause command (Spacebar) starts playback of the
audio file from the insertion point or pauses playback.

Play Selection

The Play Selection command plays only the selected portion
of an audio document.

Play w/Auditioning

The Play w/Auditioning command (a-Spacebar) plays the
selected portion of an audio document with pre-roll and
post-roll.  The pre-roll and post-roll times are designated in
the Auditioning dialog under the Preference menu.

Stop & Extend Selection

The Stop & Extend Selection command stops playback and
extends any selection from the point at which playback was
initiated. The Stop & Extend Selection command can also be
used to start playback from the insertion point or selection
start.

Fast-Forward

The Fast-Forward command places the insertion point at the
end of the audio document.

Hardware Settings

The Hardware Settings command brings up a dialog for the
audio hardware you selected in the Source dialog.  Note that
in many instances there may be no settings for a given
device (including the Apple Built-In Sound!).  Some sound
card’s drivers have control panels or utility applications that
will launch when you choose Hardware Settings. The actual
third-party dialog will differ depending on the type of audio 

card you have.

DSP Menu

This menu contains Peak Express’ DSP-based audio process-
ing and advanced editing tools. A complete description
of Peak Express’ DSP functions and instructions on how
to use them are given in 

The DSP menu

Change Gain

The Change Gain function changes the gain (i.e., amplitude)
of a selection. You can specify the amount of gain change
either in decibels (dB) or as a percentage.  If you wish to
double the volume of a sound, you must apply approxi-
mately 6 dB of gain change, or add 200%.  Enable the
Clipguard checkbox in the Change Gain dialog to protect
against the possibility of clipping.  Clipguard will search
through the audio document or  select ion for  the 

A number of DSP menu (and some other menus)
items are “greyed-out” – this is normal, as Peak
Express is a limited-feature edition of Peak.
Access to greyed-out features is available by
upgrading.



Peak Express User’s Guide 69

maximum peak in amplitude, and then limit the Change
Gain slider’s range based on the maximum peak it finds in
the audio document or selection.

The Change Gain dialog

Convert Sample Rate

The Convert Sample Rate command allows you to change
the sample rate of a sound without changing its pitch.  This
feature is very useful for converting audio material into
lower or higher sample rates as required by other applica-
tions.  Please note that sample rate conversion is applied to
an entire document.  It cannot be applied to just a selection
within a document. 

The Convert Sample Rate dialog

Invert

The Invert function allows you to invert the phase of a
selection or an entire audio document.

Fade In & Fade Out

The Fade In and Fade Out commands allow you to apply an
amplitude envelope to an audio selection.

Gain Envelope

The Gain Envelope operation allows you to enter an ampli-
tude envelope to be applied to an audio selection.  The
selected audio’s amplitude will be boosted and/or attenuat-
ed according to the envelope you draw in the Gain Envelope
editor.

The Gain Envelope dialog

Mix

The Mix command allows you to mix material that you have
copied to the clipboard with a target selection.  

The Mixer dialog

Sample rate conversion in Peak Express is limited
to 44.1 & 48kHz.
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This function can be used as a kind of “sound-on-sound”
capability for mixing audio tracks together, or for blending
sound elements.  To use the Mix command, you must first
copy a selection of audio.  The copied material can then be
mixed into the target audio material.

Normalize

This command allows you to optimize the volume of a selec-
tion or an entire audio document so that it is at its maximum
possible amplitude without clipping.  The normalize func-
tion is very useful for boosting the volume of material that
was recorded at too low a level, or if used on multiple audio
documents, for making sure that the amplitude of each of
the documents is uniform.

The Normalize dialog

Reverse

The Reverse command reverses the current selection.  In a
reversed selection, the last sample becomes the first sample,
the second-to-last sample becomes the second sample, and
so-forth.  The effect is similar to playing a record or cassette
tape backwards.

Plug-Ins Menu

The Plug-Ins menu provides access to any  installed plug-
ins.

The Plug-Ins menu

VST Plug-Ins

Selecting VST from the Plug-Ins menu will access any
installed VST audio effects plug-ins.

Audio Unit Plug-Ins

Selecting Audio Unit from the Plug-Ins menu will access
any installed Audio Unit effects plug-ins.

Bounce

Choose Bounce from the Plug-Ins menu to apply, or, ren-
der, the effect to the audio document.
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Preference Menu

This menu contains a number of commands that allow you
to customize aspects of your Peak Express software such
output volume, and other user preferences.

The Preference menu

Time Units

The Time Units command allows you to choose a time for-
mat for the audio timeline in Peak Express’ audio document
window.  You can choose samples, Min:Sec:ms, SMPTE
frames, and Bars|Beats.  The format you choose will depend
on the nature of the project that you are working on.

Sample Units

The Sample Units command allows you to select whether
sample units will be displayed in decimal, percentage, or dB.

Use Loop in Playback

If an audio document contains a loop (defined by loop
markers), the Use Loop in Playback command (a-L) allows
you to listen.  Once playback reaches the loopedregion of
the audio document the loop will begin repeating.  A check
mark next to this menu item indicates that it is enabled.  To
turn off loop playback, disable this command by selecting it
a second time.

Scroll During Play

When the Scroll During Play command is enabled, Peak
Express will “scroll” through the audio document as play-
back progresses. T his conveniently allows you to visually
follow the progress of audio playback.  A check next to this
menu item indicates that it is enabled.  To disable this com-
mand, deselect it.

Move Waveform During Playback

The Move Waveform During Play command will move
the waveform under the cursor as playback progresses, so
that the insertion point is always in the middle of the wave-
form display.  A check next to this menu item indicates that
it is enabled.

Show Overview

The Show Overview command (a-,) provides an Overview
display of the entire audio waveform along the top of the
Audio Document window under the title bar.  This provides
you with a convenient visual reference of the overall docu-
ment when you are editing only a portion in the audio doc-
ument window.

Scratch Disks

Because audio data can be very large, Peak Express utilizes a
portion of your hard disk’s free space to hold audio
documents that have been cut or copied, as well as for
temporary or “scratch” files for undo purposes.  If your
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hard disk is short on space, you may not be able to cut, copy,
or modify large selections.  If you have more than one hard
drive attached to your Macintosh, the Scratch Disks com-
mand in the Preference menu allows you to choose the hard
drives (or “scratch disks”) that you wish to use for these
temporary files. Peak Express allows you to select which disk
you want to have as your default, or “Primary” disk for this
purpose – usually you would select the disk that has the
most free space.  If you are connected to a file server, you
can utilize available storage on the server by clicking the
Allow Servers checkbox.  Any available servers will then
appear in the Scratch Disks pop-up menu. This feature is
recommended only if you have access to a high speed
Ethernet, Media Net, or other fast server.

The Scratch Disks dialog

Auto-Import Dual Mono

Certain audio applications such as Digidesign’s Pro Tools do
not directly support stereo interleaved documents, and
instead use “dual mono” documents which comprise the
right and left channels of stereo material.  Enabling the Auto-
Import Dual Mono command tells Peak Express to automat-
ically convert such documents into new stereo audio docu-
ments when you attempt to open these documents with the
Open command.  Because Peak Express actually writes a
new stereo audio file to disk, this conversion process
requires hard disk space equivalent to the two original
mono documents. (Please note that the Import Dual Mono
command requires that both files be mono documents, have
the same sample rate, and the files must have exactly the

same name with the separate suffixes of “.L” and “.R”.)

Audio Info

The Audio Info command (a-I) allows you to change an
audio document’s length, sample rate, root key, low key, or
high key parameters.  When you choose this command, a
dialog indicating the total time of the sample, its sample
rate, and its key mapping information will appear.  The
Audio Info dialog allows you to change the sample rate,
duration, root key (for use in a sample playback instru-
ment), and high and low key range.  Note that by changing
the sample rate, the pitch and duration of the sample will be
affected. (To change the sample rate of an audio document
without changing the pitch, use the Convert Sample Rate
command from the DSP menu.)

The Audio Info dialog

You can also adjust the key range (for use in a sample play-
back instrument) of a document by clicking on the minia-
ture keyboard in this dialog.  To set the lower limit of the key
range, click on the keyboard at the desired key.  To set the
upper limit of the key range, hold down the Shift key and
click on the keyboard.  To set the root key of the audio doc-
ument’s key range, hold down the Option key and click on
the keyboard.  You can also enter the desired numerical
value in any of the appropriate fields to accomplish this.
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Dynamic Scrub Time

Peak Express provides a unique audio auditioning technique
called dynamic scrubbing.  This feature is very useful for pre-
cisely pinpointing a desired location in an audio document.
Dynamic scrubbing allows you to drag the mouse forward or
backward over a waveform while Peak Express plays a short
loop (between 10 and 600 milliseconds) at the scrub loca-
tion.  You can control the tempo and direction (forward or
backward) of playback by dragging the mouse slower or
faster, forwards or backwards. When you have found the
location you are looking for, you can commence editing or
playback.  The Dynamic Scrub Time command allows you to
choose the length of this playback loop. Depending on the
audio document’s content, a value of between 40 to 80 mil-
liseconds typically works well.

Auditioning

Peak Express’ Auditioning command allows you to audition
a selection along with a specific amount of audio preceding
or following it.  The Auditioning dialog allows you to select
a desired amount of Pre-roll or Post-roll when you play the
selection.

The Auditioning dialog

Playback Preferences

Peak Express’ Playback Preferences dialog allows you to con-
trol the master output volume, hard disk playback buffer
size, and window buffer size.

The Playback Preferences dialog

Playback Master Volume

Peak Express provides a master volume control for audio
playback.  In the Playback Preferences dialog, set Peak
Express’ output volume to the level that you desire by
adjusting the slider or entering a number value from 0
(silent) to 7 (loudest). If you are controlling your playback
volume with the volume control of your playback system,
you will most likely want to leave the output level set to 7.

Playback Buffer

Peak Express allows you to control the amount of RAM the
program uses when playing back audio documents.  In gen-
eral, lower is better.  A playback buffer of 32k is a good place
to start.  If you are experiencing clicks in your playback,
working with fragmented files, using processor-intensive
real-time DSP, or are using a slow hard drive, you may need
a larger playback buffer setting.
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Window Buffer

Peak Express also allows you to control the amount of RAM
the program uses to keep audio documents buffered in
RAM.  Use larger values if you are working with a few large
files, and smaller values if you are working with many small-
er files.  Experiment to find the best settings for your system
and working style.

Auto-Balloon Help

Auto-Balloon Help, when enabled, will automatically activate
Balloon Help for items in the Toolbar if the cursor rests over
an item fro more than 2 seconds.

Floaters

Floaters are windows which “float” above open documents.
Use the Floaters dialog to specify which windows
(Transport, Contents, Cursor Palette, Movie, or VST plug-
ins) float or not.

The Floaters dialog

Window Menu

The commands in this menu allow you to display and man-
age Peak Express’ windows—including the Transport,
Toolbar, Cursor Palette, Movie Window, and any open audio
documents or active VST plug-ins.

Transport

The Transport window is a floating, re-sizable window.  It
contains three areas: a time display showing elapsed time,
the Transport controls (Return to Zero, Stop, Play, Go to
End, and Loop during playback), and audio level meters
with clip/peak indicators.

Toolbar

The toolbar contains buttons for common tasks, such as
opening and closing files, DSP tools, etc.

Cursor Palette

Peak Express has a floating Cursor palette that contains sev-
eral useful functions.  Along the top right of the palette are
four different icons representing different cursor modes.
The default cursor is a standard Arrow Cursor.  You can also
use the cursor palette to select a Hand Cursor for moving a
waveform within its window, a Pencil Tool for drawing direct-
ly on the waveform at the sample level, and a Magnifying
Glass Tool for zooming the waveform view in and out.  The
ESC key on your computer keyboard will toggle through the
four cursor modes.  The bottom half of the Cursor palette
displays the X (time) and Y (amplitude) coordinates of the
cursor point, Sel: the duration of any currently selected
audio), DTR (Distance to Reference Marker), and BPM: the
tempo in beats per minute.  You can type a value in for the
X, Sel, and BPM parameters.

Movie

The Movie command toggles the Movie window on and off
for any QuickTime movie you currently have open in Peak
Express.
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Tile Windows

The Tile Windows command (a-T) arranges all open audio
documents in a tile formation on your computer screen.
This type of arrangement allows you to view multiple open
audio documents and once, and is particularly convenient if
you are cutting and pasting between several documents or
jumping back and forth between them for editing purposes.
You can press a number key corresponding to an open audio
document and the document will become the active win-
dow. (Click the Windows menu to see the numbers that cor-
respond to each open audio document.)

Stack Windows

The Stack Windows command arranges all open audio
documents into a stack, with each document overlapping
the previous document, in the order that they were opened.
This type of arrangement allows you to have the maximum
number of documents open and use the minimum amount
of screen real estate.  You can then conveniently use the
Windows menu to select any open document and make it
the active window. Alternatively, you can press the -number
key corresponding to the open document and the docu-
ment will become the active window. (Click the Windows
menu to see the -numbers that correspond to each open
audio document.)

Links Menu

The Links menu in Peak Express provides useful links to
BIAS’  Web site. Included are the Peak Express online regis-
tration page, the BIAS home page, the Peak Express updates
page, technical support pages, online documentation, and
current BIAS product information pages.
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Chapter 9:
Using Peak Express with
Final Cut Pro 4

Introduction

Peak Express can be used in two ways – as a stand-alone
application, or as a dedicated external audio editor for Final
Cut Pro.  Peak Express is an advanced audio application that
can edit the audio from QuickTime movies and DV clips with
better-than-frame accuracy.  When working with 48 kHz
audio, Peak Express is accurate down to a 1/1600th of a
frame.

The following section will show you how to assign Peak
Express as Final Cut Pro’s audio editor, and a few tips to
sweeten the audio in your projects. 

Assigning Peak Express as an editor

To set Peak Express as an editor:

1.  Launch Final Cut Pro.

2.  From the Final Cut Pro menu, choose System 
Settings...

Opening FCP’s System Settings

3.  Click the External Editors tab

Setting Peak Express as an editor for video files that contain sound

4.  Click the Set... button in the Video Files section.

Choosing Peak Express as an editor

5.  Select the Peak Express application, and click Choose.

6.  Click the Set... button in the Audio Files section.

7.  Select the Peak Express application, and click Choose.

Peak Express is now set up as Final Cut Pro’s audio editor.
By selecting Peak Express in both the Audio and Video cate-
gories, any clips in a Final Cut Pro timeline that contain
audio can be launched into Peak Express for editing.  Audio
only clips will appear in Peak Express as a standard audio
document, and video clips with a soundtrack will open in
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Peak Express as a standard audio document, with the addi-
tion of a movie window for reference.  Clips launched into
Peak Express can now be edited with any of the tools
described in earlier chapters.  When an edit is complete,
simply save and close the document in Peak Express, and it
will go right back into Final Cut Pro’s timeline, with edits
intact, and no further need for rendering.

Examples of Workflow

An example of when you might launch an audio clip into
Peak Express for editing is the case of a pop or click.  Pops
and clicks can occur in several ways – but can be easily
repaired with Peak Express’ Pencil Tool.

The following steps show how to use the Pencil Tool to
repair a click.

To repair a click:

1.  Select an audio clip in Final Cut Pro’s timeline, that con-
tains a click.

Selecting a clip with a click that needs repairing

2.  From the View menu, choose Clip in Editor – Peak 
Express will open.

3.  Audition the file in Peak Express to locate the click.

4. When you have located the click, place the mouse
cursor directly over the click, and click into the wave
form, so Peak Express’ playhead indicator is directly 
over the click.

A click in an audio waveform

5.  Using the Zoom In command, zoom in on the audio 
waveform until you can clearly see the click.

Using the toolbar zoom buttons to zoom in 

6.   From Peak Express’ Cursor Pallette, select the Pencil 
Tool.

7.  Draw across the the area in the waveform where the 
click occurs, trying to approximate the shape of the 
waveform on either side.

Drawing out a click

Be aware that this is a “destructive” process, that will
alter the original media.  If you do not wish to alter the
original media, use Peak Express’ Save A Copy As... fea-
ture to save a copy.  Then, close the original file in Peak
Express without saving, save the copy, and import the
copy into the Final Cut Project and drag to the appro-
priate track in the timeline.
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8.   Zoom Out, and audition the file, the click should now 
be gone.

9.   To return the repaired file to the Final Cut Pro project, 
simply save and close the file and it will go right back 
into Final Cut Pro.

In other situations, you may have clips with annoying back-
ground noise, such as an air conditioning system that was
picked up by microphones at a shoot.  In cases like this, you
can take advantage of Peak Express’ realtime VST format
effects plug-in support, and use a noise reduction plug-in
such as BIAS SoundSoap to reduce the noise.

SoundSoap’s easy to use interface

To clean a file with SoundSoap:

1.  Launch a clip with background noise into Peak Express 
using the steps described above.

2. From the Plug-Ins menu in Peak Express, choose
VST>Insert 1>SoundSoap.

3.  When the SoundSoap interface appears, click the  Learn 

A demonstration version of BIAS SoundSoap is installed
along with Peak Express.  This demo version will allow
you to process files for up to 14 days.  For more informa-
tion about SoundSoap, or to purchase a copy, please
visit:  http://www.bias-inc.com

Noise button – if the file has an area of just the noise by 
itself, use this section to “Learn Noise”.

4.  Start playback by pressing the space bar, or by clicking 
the Play button in Peak Express’ transport window.   

5.  Listen to the results.  

6.  To apply/render the current noise reduction settings, 
choose “Bounce...” from Peak Express’ Plug-Ins menu. 

Congratulations!  You’ve just learned the basics of using
SoundSoap.  Now, we’ll show some advanced techniques to
fine tune the noise reduction.

7.  Turn the Noise Reduction knob all the way to the right 
for the maximum amount of noise reduction.

8.  While listening to your media, adjust the Noise Tuner  
knob to fine-tune if necessary (see tip below).

9. While still listening to your media, (in the “On” listening 
mode) slowly turn the Noise Reduction knob to the left   
to reduce the amount of noise being  taken out.  Continue 
to reduce the Noise Reduction setting until you reach 

an acceptable compromise between the amount of noise 
being reduced and any audible artifacts from the noise 
reduction process.

10.  Now, using the Mode Buttons, toggle between the “Off ” 
and “On” listening modes.  This allows you to compare 
the original noisy audio, with the results after being 
processed through SoundSoap.

A  good technique for confirming your noise reduction
settings is by switching SoundSoap into “Noise Only” lis-
tening mode.  In Noise Only mode, you will hear just the
noise that will be removed when you apply the current
noise reduction settings.  If you hear any of the audio
that should be kept in the file, adjust the Noise Tuner
knob until you hear just the undesired noise.
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11.  To apply/render the noise reduction settings to the file,  
go to Peak Express’ Plug-Ins menu, and choose  
“Bounce...”

12.  To return a cleaned file to the Final Cut Pro project, sim-    
ply save and close the file, and it will go back into Final 
Cut Pro’s timeline, with no further rendering required.

Conclusion

You’ve now successfully used some of Peak Express’  unique
editing features.  The next chapter discusses some addition-
al features available in other audio tools from BIAS.

Be aware that this is a “destructive” process, that will
alter the original media.  If you do not wish to alter the
original media, use Peak Express’ Save A Copy As... fea-
ture to save a copy.  Then, close the original file in Peak
Express without saving, save the copy, and import the
copy into the Final Cut Project and drag to the appro-
priate track in the timeline.
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• Integrated Vbox multieffects routing environment for 
arranging VST effects plug-ins in series or parallel  
arrangements, or any combination of the two.  Allows 
multiple plug-ins to be used simultaneously

•  Full DSP toolset, including all greyed-out items in Peak 
Express’ DSP menu.  Additional tools include Change 
Pitch, Change Duration, Convolve, Mono to Stereo, 

Stereo to Mono, Panner, Repair Clicks, and many others

•   Advanced looping tools, including Loop Surfer, Loop 
Tuner, and Crossfade Loop

•  Support for adding reference markers and regions

•  Advanced batch file processing – automates repetitive 
tasks 

•  Full-featured playlists – with crossfades and audio CD 
burning

•  Unlimited levels of undo/redo, independent for each 
open audio document

•  Graphical edit history

•  Insert Silence

•  Blending

•  Nudge

•  Zoom to Fit

•   Support for Sound Designer II, Raw, Sonic AIFF, .paf, 
.au, MP3, JAM Image, and System 7 Sound file formats

Chapter 10:
Other Audio Tools from BIAS

Introduction

While Peak Express is an excellent addition to the tools
included in Final Cut Pro, it is a limited-feature edition of
Peak – the industry standard in stereo audio editors.  This
chapter will cover additional features found in the full edi-
tion of Peak, as well as several other professional audio tools
available from BIAS. 

Peak (Professional Edition)

The professional edition of Peak is a full featured stereo
audio editing, recording, processing, and mastering applica-
tion.  In addition to all the features contained in Peak
Express, the full edition adds the following pro-level fea-
tures:

•  Support for higher bit depths and sample rates (up to 
32-bit, 10 mHz)

•  Support for an unlimited number of open audio docu-
ments (limited only by CPU/RAM)

•  Support for an unlimited number of simultaneous VST 
effects plug-ins (limited only by CPU/RAM)

•  QuickTime movie window scrubbing during audio selec-
tion

• Recording – including innovative Notepad feature, 
which allows reference markers to be named and 
dropped in place during recording
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•  Customizable fade in/out envelopes

•  Customizable audio document colors

•  Contents Window for easy navigation of reference mark-
ers, regions, and loops

•  Show Edits within audio waveform

•  Move waveform during play

•  Includes over 20 real-time VST effects plug-ins

•  Many other features!

SoundSoap

SoundSoap is a professional quality, yet very easy-to-use
broadband noise reduction application.  With just one click,
you can reduce/remove annoying background noise, such as
hum, hiss, buzz, camera motor noise, air conditioning sys-
tem noise and many other types of undesired noise.
SoundSoap operates as a VST format plug-in or as a stand-
alone application.  Feature highlights include:

•  One-step Learn Noise function automatically finds and 
removes noise

•  Noise Tuner lets you manually “tune-in” and eliminate 
undesired noise

•  On/Off/Noise Only listening modes allow you to deter-
mine the effectiveness of noise reduction settings, and 
compare “before” and “after” results, as well as listen to 
just the noise being removed

•  Noise Reduction knob lets you vary amount of noise 
reduction being applied

• Preserve Voice function automatically preserves fre-
quencies within the human vocal range – perfect for dia-
logue, narration, singing, etc.

•  Remove Hum feature automatically takes out 50 or 60 
Hz hum

•  Remove Rumble function removes very low frequency 
noise

•  Unique Wash Window display gives a visual representa-
tion of ratio between signal and noise, and shows just 
how much cleaning is taking place

Deck

Deck is a full-featured multitrack digital audio workstation,
featuring up to 64 tracks of recording and playback.  Deck
allows Final Cut Projects to be imported as OMF files for
quick and easy mixing in stereo or 5.1 surround sound.
Deck is renowned for its ease of use and intuitive, audio-
friendly controls, that operate in real time, with no need for
mid-project rendering.  Deck’s feature highlights include:

• Supports up to 64 tracks of recording/playback

• Sync QT movies and DV clips with better-than-frame
accuracy

• Import OMF files 

• Use real-time VST effects plug-ins – Includes over 20 
effects

•  Automate level and pan faders in mixer and surround 
panner
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• Supports external MIDI controllers

• Easily spot audio to video

•  “Rubber-Band” style breakpoint automation of levels, 
stereo panning, and surround panning 

• Mix in 5.1 surround or stereo - output 6 channels of
audio for AC3 encoding in A.Pack Encoder/DVD Studio  

Pro, or other optional encoders

•  Surround panning algoriths include Radius 5.1, Variable-
Width 5.1, & Room Ambiance 5.1

• SMPTE/EBU timecode fluent for editing, spotting, & 
external chase lock synchronization

•  Slaves with subframe accuracy to external video tape 
recorders

•  Import QuickTime movies and DV clips with better-than-
frame accuracy

•  Scrub movies with full audio chase

•  Lightning-fast spotting of audio clips to picture

• ADR capable

•  Monitor previously recorded tracks while recording new  
tracks (optionally in sync with movie)

•  Discontiguous clip selection

•  Non-destructive punch in/out

•  Many other features!

Vbox

Vbox is an advanced multi-effects control environment that
operates as a stand-alone application, or as a VST format
plug-in, within a compatible VST host application, such as
BIAS Peak, BIAS Deck, Steinberg Cubase SX, and others.
Within the Vbox effects matrix, you can combine, route, and
mix up to hundreds of plug-ins per channel of audio.  With
its ability to work with any of the hundreds of VST format
effects on the market, Vbox offers unrivaled creative poten-
tial for effects processing.  Vbox feature highlights include:

•  Create, manage, store, and recall a virtually unlimited 
number of VST plug-ins in an intuitive workspace

•  Unique effects matrix lets you route plug-ins in series, 
parallel, and hybrid series/parallel arrangements

•  Hot-swap plug-in instantly

•  Easy muting, soloing, & bypassing of any individual plug-
in

•  Full control of input and output gain for each plug-in, 
and the entire Vbox matrix

•  Master wet/dry balance

•  A/B comparisons

•  Works as a stand-alone application, or within your 
favorite compatible VST host

SuperFreq

BIAS SuperFreq is a set of four mastering quality paragraph-
ic equalizer plug-ins.  This package includes 4, 6, 8, and 10
band versions, so you always have the right EQ for the job at 
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•  Peak, High-Shelf, and Low-Shelf filters

•  Gain values +/– 18 dB

•  Q (bandwidth) values from 0.1 - 10

•  Frequency values from 20 Hz - 20 kHz

•  Individual band bypass buttons

•  +/– 18 dB logarithmic input/output level controls

•  +/– 24 dB logarithmic meters with 1 second delay

•  Carbon Event Driven (for an ultra-fast graphical user 
interface

Conclusion

We hope you enjoy using Peak Express with Final Cut Pro,
and if you would like more information about any of the
other audio tools mentioned above, please visit the BIAS
website, at:

http://www.bias-inc.com

Here you will find detailed product information, as well as
fully functional 14-day trial versions of many BIAS products.

Don’t hesitate to contact BIAS with your questions on how
our audio processing tools can make your video projects
sound as good as they look.

Email:  sales@bias-inc.com

Phone:

US:  1-800-775-BIAS (2427)

International:  +1-707-782-1866
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